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Abstract 

The energy efficiency and performance of an aluminium smelter depends critically on the 

quality and consistency of properties of the carbon electrodes that are consumed during 

the nom1al operation of the electrolytic cells or "pots". Unfortunately, although a small 

number of experts are able to assess anode quality by examining lOx images of samples, 

no objective method exists for making quality determinations. This thesis is about a 

project that has the goal of deve loping such an objective method. 

This thesi s describes methods that have been developed for the characterization of the 

microstructure of carbon anodes. As a result of the process by which they are 

manufactured, carbon anodes contain pores or voids caused by out-gasing. In this 

continuing project we have concentrated on developing means for characterising the size 

and spatia l distributions of these voids. Some of the methods used to characterise the 

spatial distribution include order neighbour analysis (a mc:thod used in geographical 

studies), and statistical tex ture analysis. These methods and the analysis described in this 

thesis are of general application. 
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1. INTRODUCTION 

The quality of the anodes used in the smelting process is of critical importance to 

aluminium manufacture. The Bluff smelter, operated by New Zealand Aluminium 

Smelters, typical ly consumes up to 400 one tonne carbon anodes every day, and as the 

smelter produces their own carbon anodes on-site it has direct contro l over the anode 

quality. 

The anodes are made up of a mixture of aggregate (85%) and pitch(] 5%). The aggregate 

is composed of the butts from old anodes, coarse coke, and crushed fines and is bound 

together with the pitch. The quality of the anodes is critically dependent on the amount of 

pitch added when the anodes are being manufactured. 

The aggregate and pitch are mixed together at 160 °C and formed with a vibration press 

into one tonne anodes a t 150 °C. These "green" anodes are then baked for approximately 

20 days at 1100-1200 °C in a large kiln . The baking process drives off the volatile 

fraction of the pitch and carbonises the remainder into coke . This release of volatiles 

forms fine voids in the binder (pitch)/fines matrix. 

Too much pitch will inevitably increase the number of voids formed, hence weakening 

the overall anode structure . This weakened structure can cause an anode to crack and 

pieces fall into the pot during smelting, which can then put the pot out of action. Also, the 

increased number of voids present in the anode increases the ai r permeability and air 

reactivity . This increases the rate at which the anodes burn away. This overpitching also 

causes "strings" of voids to form around the larger particle s (butts, coke) in the anode, 

weakening the structure. 

Too little pitch in the mixture will cause the anodes to lack binding, and be weak and 

brittle, leading to similar problems to overpitching. Underpitching also causes many 

larger voids to form throughout the anode. 

An optimum pitching level exists where anodes have a maximum density and a fine 

porous structure. 

Presently, physical properties such as the air permeability, compressive strength, 

resistivity, carbon dioxide reactivity of the anodes are measured for quality control. 

Comalco Aluminium Limited have developed a subjective optical macroscopy technique 

for assessing the pitching level and degree of compaction in baked anodes [l]. This 

method relies on the subjective visual appraisal by an expert of 1 Ox macrographs of anode 

samples. 
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The following points arose from further consultation [2] with experts in visual quality 

assessment. 

Most of the information needed to di stin g uish between ancxles of varying pitching 

level is thought to lie within the void structure. 

• Not only is the void size histogram of interest, but the relative spacing between 

voids is also important. 

• It is important to analyse a large number of images of each sample to get an idea 

of the overall structure of the anode. A single image may be misleadi ng . It is 

assumed that a single anode core sample is sufficiently representative of the 

complete anode. 

There may be slight differences in structure and texture resultin g from different 

forming processes, and different aggregate batches. 

From the above points it can be seen that it is desirable to find methods of charac teri sing 

the size and spatial distributions of th e voids within the anode samp les. This project 

outlines some quantitative image process in g methods developed to determine if 

differences in these distributions exist between anodes of differe nt pitching leve ls and 

forming conditions (ie forming temperature and time). This was undertaken as a step to 

overcoming the subjectivity of methcxls relying on human vision. 

It is believed that most of the void information lies in voids of the size range between 

0.05 and 0.7 mm in diameter as this is the void size range the visual experts use to make 

discriminations. If two pixels represent 0.05 mm then a spatial resolution of 40 

pixels/mm is needed. For the purposes of the project two spatial resolutions were 

concentrated on: 10 pixels/mm and 40 pixels/mm. The 10 pixels/mm was also chosen to 

determine if there was any gross texture pattern present. 
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2 BACKGROUND 

2 .1 Background Literature Search 

It was decided to undertake a literature search to find if there were any previous similar 

studies to thi s work and to investigate ways of charac terising the size and spatial 

distributions of the voids . The literature search found no previou s work on carbon ancxie 

quality assessment using image analysis. The search covered statistical texture analysis 

[3,4,5 ,6] as a means of charac terising the anode quality as thi s has been successful ly 

applied to industrial problems [7,8J in the past. The search :ilso concentrated on methods 

of characterising size and spatial distributions. A method found for char:icterising spa tial 

di stribution s was order neighbour analysis r91, which is widely used in geographical 

studies. 

These methods are described below. 

2. 2 Statistical Texture Analysis 

Statistical texture analysis is a powerful tech nique that is used to characterise tex ture 

features in an image in a quantitative, cons is tent and objective w:iy. The tex ture of an 

image is concerned with the spatial distribution of the gray levels in the image. This 

distribution can be deterministic or stochastic in the extreme as shown in figure 2.1. 

Deterministic textures are best analysed using strucrur:il methods such as placement rules 

and tree diagr:ims while stochastic textures such as carbon anodes are best analysed 

statistically. These stochastic textures can be analysed statistically using four different 

intermediate matrix method s [3,4,5,61 : 

1. Spatial gray level dependency method, SGLDM [3J 

2. Gray level difference method, GLDM [4] 

3. Gray level run length method, GLRLM [SJ 

4. Neighbouring gray level dependency methcxi, NGLDM [6] 

The intermediate matrices calculated from each of the above methods describe in coded 

form the spatial relationships between the gray levels in the image. These intermediate 

matrices allow the calculation of texture features to be made which in turn attempt to 

describe the texture in a meaningful way. For the purposes of this project we have 

concentrated on the most popular of the intem1ediate texture matrix based methods, the 

spatial gray level dependency method (SGLDM), because it has finer discriminating 
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power than the other statistical methods. The other three methods have been included here 

for completeness. 

• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 
• • • • • • • • • • 

Deterministic 

Stoc hastic 

Figure 2.1 - T ex ture Types 
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2.2.1 Spatial Grav Level Depe ndencv Method 

The spatial gray leve l dependency method [31 is the mos t widely used method and is 

based on the estimation of the second ord e r joint conditional probability density function s 

f(i,j ,d,a) where di s the intersample spac in g and a is th e direction (ie 0°, 45°, 90°, 135 °). 

This is illu strated in fi gu re 2.2. 

~ -,., ___ _ 

135 deg,-ee::: ·,.,_ 

Left Han1j Di;:igonal 

,;' 
/ 45 degrees 

/ Riqht Hand Diaqonal 
/ - -

/ 

·· ...... , ... __ 

-

,~ 

Figure 2.2 - Directions 

f(ij ,d,a) is the probability of going from gray level i to gray leve l}, in distanced between 

the two, and in direction a (0°, 45°, 90°, and 135 °) . If there are Ng gray level s in the 

image then the intem1ediate matrix P(i.j.d.a) is NJ.; x Ng in size. 

0 

() 

0 

2 

0 

0 
') 

2 

2 

3 

I 

2 

4 

Figure 2.3 - Simple Image 

The above method calculates four P(i,j,d,a) intem1ediate matrices, one for each direction 

a. For example, the simple image in figure 2.3 which has 5 gray levels (0-4), will result 

in four 5 x 5 matrices, one for each direction a. The resulting intermediate matrix for the 

horizontal direction is shown in figure 2.4. 
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Figure 2.4 - P(iJ,1,0): 0 ° 

The underscored 4 in the P(i ,j,l ,0°) matrix above is the num ber of times a gray level O is 

next to the same level in the image in the horizontal direction. 

The underscored I in the P(i.j, 1,0°) matrix above is the num ber of times gray level O is 

next to gray level 2 in the ill1age in the horizontal direction . 

The four P(i,j,d,a) matrices are norll1alised by ;1 normali si ng function dependant on the 

size of the Region of Interest (ROI) in the chosen ill1age to give the four intermediate 

matrices: f(i,j,d,O 0 ),f( i,j,cl,45 °),f( ij,d, 90 °), ancl f( i ,j.d, 135 °). 

Haralick et al. [3] proposed various features that can be calcutHed from the thesef(ij,d,a) 

matrices. These features are energy, entropy, inertia, homogeneity and correlation. The 

equations for these features can be found in Appendix D. Analysis of these features may 

allow discrimination between anode images. 

Energy is a measure of the homogeneity of the image. In a homogeneous image 

the energy will be high and for a nonhomogeneous image the energy will be low. 

• Entropy is a measure of the complexity of an image. The more complex an image 

is the higher the entropy is. 

• Inertia is a measure of the amount of local variations present in the image. The 

more local variations (contrast) present the higher the inertia. 

• Homogeneity is a measure of the degree with which similar gray levels tend to be 

neighbours. 

• Correlation is a measure of gray level linear dependencies. 

2.2.2 Gray Level Difference Method 

The gray level difference method [41 works on the gray level differences between two 

adjacent pixels separated by a distanced. Letf(x,y) be the digital image andf(x,y) = 

/f(x,y)j(x+,1x, y+L1y)! where Lh and L1y are integers giving the displacement d. 
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Let P' be the probability density function off'. If there are Ng gray levels in the image 

then P' has the form of a Ng dimensional vector whose ith component is the probability 

thatf(x ,y) will have value i. It is simple to compute P'(i) fromf by counting the number 

of times each value of f(x ,y) occurs. 

The above method is calculated for each of the four basic directions a as shown in figure 

2.2. 

Weszka et al. [ 4) proposed various features that can be calculated from the four P'(i) 

matrices. These features are contrast, angular second moment, entropy, mean and inverse 

different moment. The equations for these feawres can be found in Appendix D. These 

features attempt to describe the texture numerica lly. 

The contrast is the second moment abou t P'(i). This is greatest when the visual 

contrast in the image is large. 

The angular second moment is smallest when P'{i) art all as equal as possible and 

large when some v:ilues are high and some low. 

The entropy is largest for equal P'(i) and sm:illest when they are very unequal. 

• The mean is smallest when P'(i) are concentrated near the origin and largest when 

they are far from the orig in . 

2.2.3 Grav Level Run Leng:rh Method 

The gray level run length method 151 is based on calculating the number of gray level runs 

of various lengths in the four basic directions a as shown in figure 2.2. A gray level run 

is a set of consecutive co-linear pixels of the same gray level. The length of the run is the 

number of pixels in the run . 

The intermediate matrices P(i,j) specify the number of times the image contains a run of 

lengthj, in the given direction, consisting of pixels of gray level i . Let Ng be the number 

of gray levels and Nr be the number of different possible run lengths. 

Using the image in figure 2.5, the P(iJ) matrix for 0° is shown in figure 2.6. 
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() 

? 

3 
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? 
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3 

3 
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0 

Figure 2.5 - The Image 
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Figure 2.6 - P(i,.i) for oo 

The underscored 1 means the gray leve l I has one run of leng th 3 in the image. 

Galloway [5] proposed various fea rnres th at can be calculated from the four P(i ,j) 

matrices. These fea tures are long run emphasis, short run emphasis, gray level 

nonuniformity, run length no11unifor111ity and run percentage. The equations for these 

features can be found in Appendix D. These features attempt to describe the texture 

numerical! y. 

The long run emphasis gives greater weight to long runs of any gray leve l. 

• The short run emphasis gives greater weight to short run s of any gray level. 

When run s are equa ll y distributed throughout the gray level s the gray level 

nonuniformity is smallest. 

• When runs are equally distributed throughout the run lengths the run length 

nonuniformity is sma llest. 

• The run percentage is the lower for images wi th the greatest linear structure. 

2.2.4 Neighbouring Grav Level Derenclencv l\.kthocl 

The neighbouring gray leve l dependency method 1.6J is directionally independent. The 

intermediate matrix Q(k,s) is calculated by considering the rel ationship between a pixel 

and all its neighbouring pixels, at a distance less than or equal to d, at one time instead of 

in one direction at a time. 

4 4 6 C" 4 -:, _, _, 

4 4 C" -· ~. .:., (I 1 
--:, r, C" 0 (I 1 _, .:., -· 
2 0 '7 r, 3 2 1 .:., 

(I 0 '7 
1 7 

r, ..:, ,.., 
..:, 

(I 1 6 6 2: 2 

Figure 2.7 - The Image 
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For example consider the image in figure 2.7 which has 8 gray levels 0-7. 

An intermediate intern,ediate matrix P(i.j,d,a) is calculated. For the above example thi s is 

calculated on pixel 3,3 , which has a gray level of 5, in a neighbourhood of d=l around 

it, wi th the difference factor, a=zero. There is only one pixel in the neighbourhood of 

distance 1 ( d=J) with a gray level of 5 equal ( a=O) to that of pixel 3 ,3. Therefore 

P(3,3,J ,0)=(5, I ) where 5 is the gray level and 1 is the NGLDM number for the pixel 

3,3. 

The complete P(ij,1,0) for the image is shown in figure 2.8. 

(4,3) (5,2) (3,0) (0,2) 

(3, 1) (5, 1) (0,2) (0,2) 

(0,2) (7,2) (3,2) (3, 3) 

(0,3) (7,2) (7, 2) (3, 3) 

Figure 2.8 - F ( i ,.i, l ,0 ) 

Q(k,s) is the intermed iate 1mtrix for NGLDi\1 and is the total number of entries in P that 

have gray level k and NGLDM numbers . 

eg. Q(7,2)=3 because there are 3 entries of (7 .2) in the P matrix in figure 2.8. Therefore 

the Q matrix in figure 2.9 can be considered as frequency counts of the greyness variation 

of an image. It is similar to the histogram of the image. 

0 

l ~~'liY. 2: 

L~~-;.,~./ ':• _, 

:,. -·- <1 
C" -· 
6 
., 
( 

I] 

0 [I 

0 [I 

0 0 

1 

(I [I 

I] 

0 (I 

I] 0 

~ 

4 

0 

0 

0 

1 

I] 

':• _, 

0 

0 

2 

0 

0 

0 

Figure 2.9 - Q(k,s) 

As shown above Q(7,2) = 3. 

4 5 6 7 

(I (I (I 0 

0 0 0 0 

0 0 0 0 

0 0 0 0 

(I (I (I 0 

0 (I 0 0 

0 0 0 0 

(I 0 0 0 

Sun and Wee [6] proposed various features that can be calculated from the Q(k,s) matrix. 

These features are small number emphas is, large number emphasis, number 

nonuniformity, second moment and entropy. The equa1ions for these features can be 

found in Appendix D. These features attempt to describe the texture numerically. 
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• The small number emphasis is a measure of the fineness of the image. The finer 

the image is the larger the small number emphasis is. 

The large number emphasis is a measure of the coarseness of the image. The 

coarser the image is the larger the large number emphasis is. 

• The number nonuniformity is related to the coarseness of the image. 

• The second moment is a measure of the homogeneity of the image. The larger the 

second moment is the more homogeneous the image is. 

The entropy is related to the coarseness of the image. 

2 . 3 Order Neighbour Analysis 

Order neighbour analysis [9] is a method used in geographical studies to analyse point 

patterns in order to charac terise the spatial distribution. Order neighbour analys is 

recognises three types of point pattern : clustered, random and dispersed. These are 

shown in figure 2.10. 

_: ~\'·.=:··: ··. 
-.~ .:·:·: . : ./,-: .. -
,\:_: _.;\-':_· 

.. · . 
• _< __ -·/ ' -:·. 

Random Clustered Dispersed 

Figure 2.10 - Point Pattern Types 

The distance to the nearest neighbour is calculated for each of the points in a pattern and 

from this data an R statistic can be calculated for the nearest ne ighbour level. It is 

assumed that there is no boundary around the point pattern as this will restrict the 

directions in which distance measurements can be made. This R statistic gives a statistical 

indication of the randomness of the spatial distribution of the pattern and the standard 

deviation for each R value can also be calculated. The equations for the R statistics and 

its standard deviation for the nearest neighbour level and the boundless case are shown 

below in equations 1 to 3 inclusive. 

where 

R(l) = r(l) 
p(l) (1) 

r(l) is the average nearest neighbour distance for the point pattern 

p(l) is the mean point to point distance for a random pattern 
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( 
N )--0.5 

pO)=o.s A 

where N is the number of points in the pattern 

A is the area covered 

o-[ R(I)] = 0.5228N-0 5 

(2) 

(3) 

Adjustments can be made to the R statistic and its standard deviation to take in to account 

a boundary being placed around the points. 

An R value of 1.0 (within the statistical bounds) indicates that the image is random. If the 

calculated R statistic is below the lower stati stical bound then the image tends towards a 

clustered pattern and if the calculated R stati stic is above the upper statistical bound then 

the image tend s towards a dispersed or regular pattern. 

Aplin al so suggests that t\\'O point patterns can be stati stically distinguished from one 

another by applying a two-sample Kolgomorov-Smirnov (KS) l 1 OJ goodness of fit test to 

the cumulative di stribution s of the nearest neighbour di stances. The KS test is described 

below. 

2.3.1 The Two-sample Kol~omorov-Smirnov Goodness of Fit Test 

The two-sample KS test is a rest of wh ether two independent samples have been drawn 

from the same population (or from population s with the same distribution). The two­

tailed test is sensitive to any kind of difference such as a change in the mean or variance in 

the distributions. The KS test is concerned with the agreement between two cumulative 

distributions. If the two samples have been drawn from the same population distribution , 

then the cumulative distributions of both samples may be expected to be similar allowing 

for random fluctuations. If the two cumulative distributions are too far apart at any point 

then the samples may have come from different populations, allowing for the level of 

confidence. 

To apply the KS test, cumulative frequency distributions are constructed for both of the 

point patterns to be tested, using the same intervals for both distributions. For each 

interval, one of the distributions is subtracted from the other and the largest absolute 

deviation is used in the KS test. This largest absolute deviation is then compared to the 

critical KS value which takes into account the number of points in each pattern and the 

desired level of confidence. If the largest absolute deviation is greater than the critical KS 

value then the two distributions are statistically different. These points are illustrated in 

the example below. 
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2.3.1.1 KS Test Example 

Sample Intervals (mm) Pattern I Cumulative Pattern 2 Cumulative 

Distribution Distribution 

< 0.04 () 0 

0.04 - 0.095 35 40 

0.095 - 0.15 250 176 

0.15 - 0.205 811 602 

0.205 - 0.26 1388 1073 

0.26 - 0.3 15 1953 1575 

0.315 - 0.37 2372 1970 

0.37 - 0.425 2725 2262 

0.425 - 0.48 2897 2454 

0.48 - 0.535 3012 2586 

0.535 - 0.59 3086 2665 

0.59 - 0.645 3161 2718 

0.645 - 0.7 3193 2754 

0.7 - 0.755 3205 2773 

0.755 - 0.8 1 3214 2787 

0.81 - 0.865 3224 2792 

0.865 - 0.92 3226 2802 

0.92 - 0.975 3226 2806 

0.975 - 1.03 3227 2806 

1.03 - 1.085 3227 2806 

1.085 - 1.14 3228 2806 

Figure 2.11 - Cumulative Distributions 
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Pattern 1 Cumulati\'e Pattern 2 Cumulative Absolute Differences 

Frequency Distribution Frequency Distribution 

0 () 0 

0.0108 0.01 42 0.0034 

0.0774 0.0627 0.0147 

0.2512 0.2145 0.0367 

0.4299 0.3823 0.0476 

0.6050 0.56 12 0.0437 

0.734 8 0.7020 0.0327 

0.8441 0. 806 1 0.0380 

0.8974 0.8745 0.0229 

0.9330 0.9215 0.0114 

0.9560 0.9497 0.0062 

0.9792 0.9686 0.0106 

0.9891 0.98 14 0.0076 

0.9929 0.9882 0.0046 

0.9956 0.99 32 0.0024 

0.9987 0.9950 0.0037 

0.9993 0.9985 0.0008 

0.9993 l 0.0006 

0.9997 I 0.0003 

0.9997 l 0.0003 

1 l 0 

Figure 2.12 - Differences 
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Figure 2.11 shows a table of the cumulative distributions of the nearest neighbour 

distances for two different point patterns. 

The next step is to normali se the cumulative distribution with respect to the total number 

of points in each pattern to give the cumulative frequency distributions. For the first 

pattern the total number of voids is 3228, and for the second pattern it is 2806. 

The KS test is performed on the cumulative frequ ency distributions firstly by finding the 

largest absolute difference between the two di stributions and comparing this value to the 

critical KS value. Figure 2. 12 shows the cumulative frequency distributions and the 

resulting absolute differences. The largest absolute difference is shown in bold type. 

The largest absolute deviation bet\\'een the two cumulative frequency distributions is 

0.0476. Thi s value is compared to the critical KS value which takes into account the 

number of observations (points in each pattern) and the desi red level of confidence. If the 

critical KS value is less than 0.0476 then the two patterns are statistically different (ie the 

largest absolute deviation is greater than the critical KS value). For the 99% level of 

confidence the critical KS value was ctlc ulated a~ shown in equation 4 [ 10): 

KS = 1.0~ /ni + 11
" 

c~rlf ~ \ • 

y 11:llc (4) 

Where n1 and 112 are the 101:tl number of points in patterns I and 2 respectively. 

For this example the critical KS value is 0.04207. which is less than the largest absolute 

deviation. This means the two point patrern spatial di stributions are different at the 99% 

level of confidence. Another useful measure is to calculate the KS ratio which is the 

largest absolute deviation divided by the critical KS value. In this case the KS ratio is 

1.13. As the KS ratio is greater than 1.0 then we can say the two point pattern spatial 

distributions are different. A KS ratio less than 1.0 would indicate that the spatial 

distributions were the same. This measure gives an indication of the amount of 

difference. 

The sensitivity of the KS test was tested using gaussian curves based on equation 5: 

[
(z-ul'] I . . 

y(x) = --=e - 2..r 
a..j(:. ,r) 

where a is the standard deviation and ,LI is the mean. 

(5) 

Two gaussian curves with a mean of 0 and a standard deviation of 1 were created and the 

standard deviation of one of the curves was increased. The KS ratio was calculated at a 

99% level of confidence as the standard deviation increased. The standard deviation at 

which the KS ratio became 1 was found to be 1.019 or a 1. 9% increase. 
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T he process was then rereared for a dc>creasing s tandard deviation at a 99% level of 

confidence. The resulting sranclard deviarion at whic h the two distributions became 

significantly differenr was fou nd to be 0.981 or a 1.9% decrease . 

The process was then repealed for a changing mean at a 99% level of confidence where 

the standard deviation was kepi constant. The resulting mean at which the two 

distributions begin to differ was 0.06167. 

From the above sensitivity res ts ii was conclmkd that the KS test is quite sensitive to 

small variations in the mean and srandard deviations of the distributions being tested. 
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3 TOOLS USED 

This section describes the hardware and software used in the project. The preparation of 

the sample anodes and th e image capture process is also described. The final part of the 

section describes the image processing routines implemented in the project. 

3 .1 Hardware Used 

The computer hardware used in the project consisted of three main components: 

• A host computer 

A fram e-grabber 

• A so lid-state camera 

Each of these will be discussed in more detail he low. 

3 .1.1 The Host Computer 

The host computer used fo r thi s project was a i\facintosh Quadra 900 running Operating 

System 7.0.1 with 8 f\'lb of RAiVI. The "Jm:ige" [l l ,12J and "VIPS" (13] image 

processing software were installed on thi s comp uter. The frame-grabber card and 

associated utilit y software (QuickCapturen1
) \\'ere also installed on the Quadra and as the 

"Image" software supported the frame-grabber direct ly, the images were captured within 

"Image". 

3.1.2 The Frame-r:rabber 

The frame-grabber used \.vas an 8-bit Data Translation (DT2255-50Hz) QuickCaptureD1 

card which captures 512 lines x 768 pixels . 

3.1.3 The Camera 

The camera used was an Ikegami ICD-44DC black and white solid-state video camera. A 

black and white camera was chosen because a colour camera requires the colour 

subcarrier signal to be filtered out before being used with a monochrome frame-grabber. 

This camera incorporates a 1/2 inch CCD image sensor with 512 horizontal and 582 

vertical picture elements. The lens used to capture the images had a focal length of 25mm. 

3. 2 Sample Preparation 

An anode sample is nom1ally in the fo1111 of a flat slice about 50 mm2 in area. The voids 

of interest are the cavities formed by this slice through the 3-D matrix of the original 

anode as shown in figure 3.1. 
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Fi gure 3.1 - r\11ocl e Sampl e a t a 40 pixel /mm Resolution 

Si nce we are look ing :1t the size and spa tial distribu tions of the voids, the voids have to be 

di stinguished from the background in some w:1y . Two methods were tried: 

• Direc t/Side lighting 

Void fil li ng 

In the fi rst method, images of the same scene were capt ured wi th direct lighting and then 

with side li ghting. Whe n the images are subt racted the resulting image should show th e 

voids. Thi s method was abandoned because we co ul d not get adequate direc t li ghtin g 

onto the anode samr les at hig h magni fications because of the small camera to sample 

di stances. 

The second method invo lves filling the voids with a white substance to contrast the voids 

to the gray background . Firstly chalk was used to fill the voids by rubbing a stick of 

chalk over the polished anode su1foce. Th is was not very successful as the chalk would 

not fill the largest voids and since the voids were filled with dust, the dust sometimes 

came out of the voids . This problem was rectified by using plaster of paris instead of 

chalk. A wet plaster mixture was spread over the anode surface using a wall paper 

stripper to fill the voids, then the wet su1face was scraped to remove the excess plaster. 

The plaster was left to dry and given a light rub with a rag to remove the plaster from the 

anode surface. This method resulted in the plaster filled voids having a high contrast to 

the background as shown in figure 3.2. 
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Fig ure 3.2 - A nother Sa mple at 40 Pixels/mm after Plaster Applied 

Once the voids have been filled using plaster the image can then be thresholded to identify 

the voids as shown in figure 3.3. Note for convenience the images have been inverted; 

the black areas correspond to the voids and the white area corresponds to the background. 

From these binary images further analyses can be perfonned to characterise the size and 

spatial distributions. 

Figure 3.3 - Thresholded Result 
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Once images of the requi rl!cl sp:ttial reso lution have been captured in "Image" the 

resolution of 10 or 40 pixels/mm can be set into "Image" to ca librate the pixel 

measurements into SI units. 

The next step in the process was to capture images of the anode samples. 

3 . 3 Image Ca pture 

Images were captured using the arrangement shown in figure 3.4. This set-up was inside 

a booth with curtains to keep out background light. 

The camera was mounted on an adjustable mount which al lowed the user to set the height 

of the camera above the sample. The lighting was provided by four moveable lamps 

which were adjusted to give an even lighting over the sample. The sample was placed 

inside an X-Y table ro move the s:imple in the horizontal and vertical directions nOimal to 

the camera. 

Figure 3.-l - Capture Set -up 
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To capture an image, the prepared sample was placed in the X-Y table directly below the 

camera and lens arrangement. T he '' Image" software was run and the live capture 

command was chosen. The c:une ra lens and the he ight were adjus ted to give a sharp ly 

focused image. The lighting was then adjusted to give un iforrn illumination. The lighting 

was checked by constructing plot profi les of the illumination in the vertical and hori zonta l 

directions on the captured images in "Image". Ir there was a significant slope in the gray 

sca les w ith respect to the number of pixe ls then the ligh ti ng was uneven and the ligh ti ng 

adjusted accordingly. 

To ca librate the spat ia l resolut ion, :1 scal ed rukr was placed under the camera on top of 

the sample and a focused im:1ge of the ruler \\':ts captured. Using "Image", the number of 

pixels between two points on the rukr \\':ts me;isu red . S ince the actual physical dis tance 

and the num ber of pixels between two points w:is known, the spati a l calibration in 

pixe ls/unit di s tance coul d be cilcuLtted. "Image" allows this spati al calibration to be 

entered in S I unit s and afte r calibration. all subseq uent calcul ations are ou tpu t in the SI 

unit spec ified rather than pi xels. 

3 . 4 Software Used 

The m ajor software appli cations th:it were used in the practical part o f the project were 

"Image" [1 1,12) and "Exce l". 

"Image" is a public domain image processing and analysis program for the Macintosh, 

writte n by the American N:n ional lnstiwte of Health. l t supports al l major image fil e 

fom1ats suc h as TIFF and PICT and any measurements made can be saved as "Excel" text 

fi les. It s upports many st;indard image processing fu nc tions , including hi s togram 

equalisat ion, contrast en hancement. de nsity profi li ng, smoothing , sharpe ning , edge 

de tection, median filtering, and spatial convolut io ns. Image can also be used to measure 

the areas, positions, and perimeters of binary blobs (voids) in a n image. The major 

reason "Image" was c hosen was because of the Pascal-like macro language for 

automating repetitive tasks, and the availabi lity of the complete Pascal source code. The 

structure of the source code allowed the easy add ition of user defined image processing 

routines at the source code level. This approach was used throughout the project. 

"Excel" was used mainly because it is the spreadsheet used on the Macintosh computers 

in the Department, and the compatibility w ith "Image" was coincidental. "Excel" was 

used to process the raw measurement data from "Image" and to perform the KS tests. 

3 . 5 Image Processing Routines 

As mentioned earlier, "Image" allowed the easy addition of extra image processing 

routines. The image processing routines added for this project were: 
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Stat istical Texture Analys is I 3,4,5,6 1 

Rank and Range Filters I 14 I 

Area/Distance Factors 

• Weighted Area 

• Nearest Neighbour An:tlysis (Spatial Distribu tion) [9J 

Circularity 

Connec tivi ty 

Texture Primitives I 15I 

A user manua l out lining the above routines c1n be found in Appendix A. Of the above 

routines, the area/distance factors, the weighted area , the circularity, and the connec tivity 

were features crea ted especially fo r this project. whereas the other routines were wri1ten 

by others. All the above routines except the stati stical texture analysis and the ran k/range 

filters are specifica lly designed to be run 011 hi11ary images which show the voids as black 

and the background as white. 

3.5. 1 Statistical Texture A11 alvsis 

Statistica l tex ture analys is techn iq ues were descri bed in Section 2.2. The four maj or 

stati sti ca l me thods (SG LD M, GLD i\l. GLRLM, and NGLDM) were implemented in 

"Image" and the source code can be found in Appendix B. 

3.5. 2 Ran!!e and Rank Filters 

As "Image" did not have a rank or ran~e filter I 14J available, it was decided to add them 
~ -

for future use and completeness. A rank fi lter is a local operator fi lter which uses the pixel 

values contained in a window around and including a particular pixel. For this project a 

window of 3 x 3 was used. 

The rank filter works by sorting the 9 pixe l values in the 3 x 3 window into numerical 

order from O (white) to 255 (black). Note that Macintosh computers regard a O pixel value 

as white, and not black as most other systems. For a rank filter of rank 1 (a MIN filter) , 

the central pixel in the 3 x 3 window is replaced by the lowest value of the soned pixels in 

the window. Similarly for a rank filter of rank 9 (a MAX filter), the central pixel in the 3 

x 3 window is replaced by the highest value of the sorted pixels in the window. A rank 

filter of rank 5 acts as a median filter and replaces the central pixel by the median of the 

sorted pixels. The MIN filter will remove layers of pixels from the black voids in binary 

images, and the MAX filter will add layers of pixels to the black voids. When the rank 
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filter command is run in "Image", the user is asked the rank (from 1 to 9 inclusive) to be 

used. 

The output of a range filter is the difference of two rank filtered images. This subtraction 

means the range filter is useful as an edge detector. When the range filter command is run 

in "Image", th e user is asked the ranks (from I to 9 inc lusive) of the two rank filters to be 

subtracted. The value of the second rank entered is subtracted from the first. 

A problem with window filters such as the rank and range filters is th at the outside layer 

of pixels around the image does not have an output. Other image processing systems such 

as VIPS [1 3] extend th e second layer of pixels out to the outermost layer, and this 

approach was implemented in "Image" as th e EXTEND command. When the rank or 

range filter is run in "Image" on any image , th e oute rmost layer of pixels is set to white. 

This will remove any void pixels (black ) touching the edges of a binary image when 

using the rank filter as a l\'I IN filter. The EXTEND command may be used to extend 

grayscale images if desired. 

The source code for th e rank and range filter routines can be found in Appendix B. 

3.5.3 Area/Distance Factors 

The area factor (AF) measures th e spatia l and size distribution from the areas and 

distances between all the voids in an im age. For an image, the AF is calculated as 

follows: 

AF = - I I----½-I ''"[" Al 
N i=I j=l ( dij) 

l :;t j 

where N is the total number of voids in the image 

A j is the area of the jrli void 

dij is the distance between the irh and )Liz void 

(1) 

The distance factor (OF) quantifies only the spatial distribution of the voids. This measure 

is the same as the area factor except that it is not weighted by the areas of the voids. 

DF = _!_ ±[±-1 
2 ] 

N i=I j=I ( dij) 
1-:t:-j 

(2) 

When "Image" runs the area and distance factor routines, the result is a column of area or 

distance factors which shows the individual area or distance factors for each void. In 

order to get the area or distance factor for the image as a whole the resulting column 

above is averaged to give the equations above. 
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The source code for the area and di stance factors routines can be found in Appendix B . 

3.5.4 Weighted Area 

This is a measure of th e volume of th e void s in a sample. It is assumed that the larger the 

cross-sectional area of a void in our image of a sample, the larger the volume of the void 

in the original materia l will be. Each pixel within a void is weighted in proportion to its 

distance from th e edge. The weighted area (WA) is calculated by using a MIN filter to 

remove th e outermost layer of pixels from all of the voids in the image. The change in 

total area is given a weighting of I for the first layer removed, a weighting of 2 for th e 

second layer etc, a s show n in figure 3.5. The process is repeated until all the voids in the 

image have disappeared, that is eroded to nothing. The area changes for each layer 

removed , along with th e resrective weigh tings, :ire summed to give a weighted area for 

the image as a whole. 

La·-,.·e.r· ·1 - ···/·/e.iqf·1tinq 1 
! y ~ · 

I I La,:/e.r- 2 - \1·/e. i•J hti n9 2 

I 

Figure 3.5 - \VA Four Layers 

The weighted area can be summarised in the following equation : 

Where 

N 

WA= IJA, 
i=I (3) 

N is the number of layers in the void 

Ai is the area of the layer 

The source code for the weighted area routine can be found in Appendix B. 
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3.5 .5 Nearest Nei£!. hbour 

In this routine the nearest neighbour distances are calculated for characterising the spatial 

distribution. The data from this routine is analysed in "Excel" for the KS tests. "Image" 

calculates the di stance to the nearest eigh t neighbours for each vo id in the image. If the 

di stance to the nearest boundary is closer to a void than the distance to its first nearest 

visible neighbour, then the firs t nearest neighbour dist:rnce for that void is not used. This 

logic is used bec:wse what lies ou tside the boundary is unknown. If a void has no first 

neares t neighbour then it cannot possibly have a second or th ird and so on. This process 

can be repeated for higher neighbouring levels. Therefore, if the distance to the nearest 

boundary is closer 10 a void than the distance to its second nearest visible neighbour, then 

the second nearest neighbour di stance for that void is not used. Thi s logic is aga in applied 

because what li es outs id~ th~ boundary is unknown. If a vo id has no second nearest 

neighbour then it cannot possibly have a third or fourth and so on. It must be remembered 

that the project conce ntrated on the (fi rst) nearest neighbour distances for use in the KS 

tests. The average of the ne:,rest neighbour di stances is also used as a feature for making 

discriminations betwee n anodes (see section 3.6). The higher neighbour levels were 

included for completeness and potential use in more complex KS testing in the future. 

Each ti me the neighbour level increased, the effective area over which the neighbours 

were analysed grew smaller. This occurs because the outer voids were being ignored as 

they were closer to the boundaries of the image than thei r neares t visible neighbour. 

These area changes are noted by "I mage" and recorded for use in calculating the R 

statistics in "Excel". These R statistics can be assumed to have no boundary as only voids 

which have visible nearest neighbours closer than the nearest boundary are accounted for. 

For this reason the equat ions shown in section 2.3 can be used for the nearest neighbour 

level without making any adjustments for a boundary. 

The source code for the ne ighbour analysis routine can be found in Appendix B. 

3.5.6 Circularirv 

This routine measures the lengths of the major and minor axes of the best fitting ellipse of 

a void in an image. The circularity is the length of the minor axis divided by the the length 

of the major axis. Therefore a circularity of 1.0 would indicate a perfectly circular void. 

The lower the circularity, the longer and thinner the void in question. The circularity 

measure works best on voids with a large number of pixels as the circularity measure is 

distoned when measuring extremely small voids ( <20 pixels). 

The source code for the circularity routine can be found in Appendix B. 
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3.5.7 Connectivitv 

During investigations into effects of the MAX filter on the void images, it was decided to 

look at the changes in the number of void s in th e image as successive layers of pixels 

were added to th e void s. This change in the vo id count as layers of pixels were added 

was called connectivity. The final result of the connectivity analysis is one single blob 

where all the original voids in the image ha ve been connected together. The result of this 

analysis is a plot of the number of voids as a function of the number of layers added. This 

plot is shown in figure 3.6. 

Connectivity 
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Figure 3.6 - Connecti,·ity Results 

The connectivity plot shows the changes in the void count as successive layers of pixels 

were added to the voids in the image. The plots of different images could be compared by 

plotting on the same graph and visually inspecting them. 

Another way to compare connectivity plots from different images would be to use the KS 

test as these connectivity plots could be viewed as cumulative plots. A problem with this 

method is the different number of layers added in different images. This is a problem 

because the KS test requires the x axis for all the plots being compared having the same 

number of points or bins. Normalisation of the x axis to a single number would be 

difficult as this would require complex interpolation of the data. 

When the connectivity routine is run in "Image" the number of voids in the original image 

is counted and recorded. Next a layer of pixels is added to the voids and the count is 

recorded. This process is repeated until there is only one void left and the data is 
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displayed for saving by the user. To avoid a limitation inherent in the void counting 

algorithm used by "Image", a new void counting algorithm was written for the 

connectivity routine to overcome thi s. This new void counting algorithm was a modified 

blob counting routine from VIPS f 13 J called BLOB. 

3.5 .8 Texture Primitives 

This routine uses various attr ibutes of the texture primitives [15J (in this case the voids) 

such as the area, perimeter, compactness, eccentricity, and direction to analyse the 

images. The area and perimeter of a void are self-explanatory. The compactness is the 

ratio of the square of th e perimeter to the area. The eccentricity is the inverse of the 

circularity, and the direction is the angle the major axis makes with the horizontal. 

The steps "Image" takes to calculate the texture primitives are as follows: 

The attributes (area, perimeter, compactness , eccentricity, and direction) are 

calculated for each void in the image 

For each void the four nearest neighbours are found 

• Primitive attribute co-occurence matrices are constructed for each attribute 

Second-order statistics are calculated from these co-occurence matrices 

The first two steps have been discussed earlier. The final two steps resemble statistical 

texture analysis. 

For each of the attributes, the values are divided into N= 16 intervals . These intervals 

form an N x N co-occurence matrix for each attribute. To construct the co-occurence 

matrix P for the area attribute say, each void and it four neighbours are looked at. If the 

area for a particular void is in interval i and the nearest neighbour's area is in interval j, 

then we add 1 to P(iJ), the (i,jth entry of the area co-occurence matrix. Finally, the matrix 

is normalised by dividing each entry of P by: 

,v ,v 

IIP(i,j) 
i=l j=I (4) 

From the co-occurence matrix for each attribute, the following second-order textural 

statistics are calculated: 

• Angular Second Moment (ASM) 

N N 

ASM = II {P(i,J)}2 

i=I j=I (5) 
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• Entropy (ENT) 

/v /v 

ENT= - I, I, P(i ,j) log ( P(i,j)) 
i=I j=l 

In verse Different Moment (IDM) 

Contrast (CON) 

/D1\.1 =If P(_i,j) :? 

i=l j=I I + ( I - j) 

N .V 

CON= II {U- J)2 P(i,J)} 
i=I j=l 

(6) 

(7) 

(8) 

When the tex ture pnm1t1ve routine is run. "Image" calculates a table of 20 texture 

primitives, ie four columns of seco nd-order sta tisti cs and five rows of attributes. These 

second order stati stics allow the discrimi nation of images with different textures. 

3.6 Features Used 

For the purposes of the pro_1ect it was decided lO concentrate on th e following ten 

features. 

1. Energy 

2. Entropy 

3. Inertia 

4. Homogeneity 

5 . Correlation 

6. Area Factor 

7. Distance Factor 

8. Average Area of the voids present in an image 

9. Weighted Area 

10. The Average Nearest Neighbour Distance · 

The first five features are the second-order statistics from the spatial gray level 

dependency method, and the last five have been described above. 
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4 RESULTS AND DISCUSSION 

4.1 Introdu c tion 

As discussed in earlier sections, the size and spatial distributions of the voids in an anode 

sample are important for assessing the effect of pitching level on the quality of the anode. 

For this reason, it was decided to investigate the changes or trends in the area and nearest 

neighbour distance distributio11s and the image features described in the previous chapter 

with respect to the pitch ing level and the forming conditions of the anodes . This will 

characterise the area and spatial dist ri bution's sens itivity to changes in pitching level and 

forming conditions. 

The ten image features that were used were the five SGLDM texture analysis features, 

namely: energy, entropy , inertia. homogene ity , and correlat ion; and the area factor (AF), 

distance factor (OF), the awrage area of the voids, the we igh ted area (WA) and the 

average nearest neighbour distance (NJ\). 

The pitching levels looked ac " 'ere classified by Comalco as: underpitched (UP), good, 

slight ly overpitched (SOP). and overpitched (OP). le must be noted that these pitching 

levels are not measured values. but are assessments made by visual inspection of the 

anode samples by an expert (See Appendix F). 

The fom,ing condition paramecers considered were: the time the green paste spent in the 

vibration former, and the temperature. Anode samples formed under six different 

conditions were compared: 

1. 25 seconds in the vibration fom1er at a temperature of 147 cc (25@147). 

2. 25 seconds in the vihration fom1er ac a temperacure of 149 cc (25@149). 

3. 45 seconds in the vibration fom1er at a temperature of 153 cc (45@153). 

4. 45 seconds in the vibration fom1er at a temperature of 155 cc (45@155). 

5. 75 seconds in the vibration former at a temperature of 145 cc (75@145). 

6. 75 seconds in the vibration former at a temperature of 151 cc (75@151). 

For both the pitching levels and forming conditions, analysis was performed at 10 

pixels/mm and 40 pixels/mm resolu1ion for reasons slated earlier. 

For all the above conditions, the image features were graphed against the changes in 

pitching level and forming conditions. Visual trends and high statistical correlations 

between image features and the pitching level or forming conditions were looked for. 
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Kolgomorov-Smirnov (KS) tests were performed on the area and nearest neighbour 

distance distributions to look for differences (or similarities) between anode samples. 

4. 2 Changes in Pitchin g Level 

4.2.1 IOpixels/mrn 

4.2. I. I l 1J1age Fem11res 

Images of a resolution of IO pixels/mm were captured for each of the prepared samples of 

different pitching levels . At this resolution only one image could be obt:1ined from e:1ch 

sample. These images were 256 x 256 in size and covered an area of 27.23 mm x 27.23 

mm (741.5 111111'.\ This provicted four images to work with. one of each pitching level. 

For each image. the image featu res were calculated using "Image" and "Excel", and the 

area and nearest neighbou r distance distributions ,.vere also noted. Graphs of the im:1ge 

features as a function of the pitching level are shown in Figures 4.1 to 4.10 below. 
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Figure 4.3 - Inertia vs Pitching Level 

30 



Homogeneity 

0.2 

0. 18 

0 .1 6 
>- 0. 14 
Q,) 

0. 12 C: 
a, 
0) 

0 
0 . 1 

E 0.08 
0 
I 0.06 

0.04 

0.02 

0 

UP 

Pitching Level ( Inc re as ing ->) 

Fi gure -l . -l - Homogeneity YS Pitching Level 

Correlation 

0.9 

0.89 

0.88 
C: 
0 

0.87 -(ll 

a, 0.86 .... ... 
0 0.85 
() 

0 .84 

0 .83 

0.82 

UP CP 

Pitching Level (Increasing ->) 
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Figure 4.7 - Distance Factor vs Pitching Level 
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Figure 4.9 - Weighted Area vs Pitching Level 
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From the above figures it can be seen that some of the im:ige features vary systematically 

according to the pitching level. These features are inertia. homogeneity and distance 

factor. It remains to be seen if these trends are confirmed for samples wi th accurately 

known pitching levels. 

4.2.1.2 Area and Sr)(/riol Disrrih11rio11s 

For each of the anode samples the area and nearest neighbour distance distributions were 

measured. A cumulative histogram was constructed using "Excel" for each area 

distribution using the log of the area since there are many more smal l voids than large 

voids. A cumulative hi stogram was also constructed for the nearest neighbour di stance 

di stribution. 

Kolgomorov-Smirnov (KS) tests were used to determine if the area and nearest 

neighbour distance distributions for each of the pitching levels are different from each 

other, that is the pattern of voids in the two samples is different. 

For the pitching level data the cumulative log area histograms are plotted in figure 4.11. 

The area distributions have been nom,alised ac<..'.Ording to the number of voids detected in 

the image. 
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KS tests were perfonned at a 99% level of confaknce between the fou r pitching levels for 

the area distribution and results are shown in figure 4.12. 

UP Good SOP OP 

UP Same S:1me Same Same 

Good Same Same Same Same 

SOP Same Same Same Same 

OP Same Same Same Same 

Figure 4.12 - KS Results for the Area Distribution at a Confidence Level 

of 99% 

This table shows that the area distributions for all pitching levels at a resolution of 10 

pixels/mm are the same. The KS tests were repeated for a confidence level of 95% and 

the underpitched anode was found have a different area distribution than the good anode 

and the slightly overpitched anode. The underpitched anode was the same statistically as 

the overpitched anode. This is shown in figure 4.13. 
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UP Good SOP OP 

UP Same Different Different Same 

Good Differen t Same Same Same 

SOP Differem Same Same Same 

OP Same Same Same Same 

Figure 4.13 - KS Res ult s fo r th e Arca Distribution at a Confidence Level 

of 95 9c 

The KS tes ts themse lves clid nor have to be repeated for th e 959c confidence level as the 

KS ratios for the 99% confidence kvel rests cou ld have been multiplied by a factor of 

1.63/1.36 (""1.2). This adjustment factor is the r:1tio of the KS criti cal value for the 99% 

confidence level divided hv the KS cri tical ,·:tlue for the 95% confidence level (See 

Appendix C). Any KS ratios now 0\ er 1.0 indicate that particular KS tes t has no w 

become sig nificant. 

For th e pitching level dat:1 the cumu lative ne:1res t neighbour distance hi stograms are 

plotted in Figure 4. 14. The nearest neighbour clist:111ce distributions have been nom1ali sed 

according to the number of nearest neighbour measurements made in the image. 
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KS tests were performed between the four pitching levels for the nearest neighbour 

distance distribution and the following table resulted in figure 4.15. 

UP Good SOP OP 

UP Same Same Same Same 

Good Same Same Same Different 

SOP Same Same Same Same 

OP Same Different Same Same 

Figure 4.15 - KS RC'sults for the Sp:1tial Distribution at a Confidence 

Le,·el of 99 % 

The good anode h:1s a significant ly different sp:1tial distribution from the overpitched one 

at a 99% level of confidence. The KS r:1tio for th is test was 1.05 so the spatia l 

distributions were only m:1rgin:llly different. The KS tests were then repeated for a 

confidence leve l of 95 % and the overpitched anode was also found to be different from 

the good and the slightly overpi tched anodes. The KS ratio for the 

overpitched/underpitchecl test was 0.98 so if :111 even lower confidence level had been 

used then the spatial distribution of the overpitched anode would have been significantly 

different from all th e other pitching kveb. This would allow discrimination of the 

overpitched anode from the others. This is shown in figure 4. 16. 

UP Good SOP OP 

UP Same Same Same Same(0.98) 

Good Same Same Same Different 

SOP Same Same Same Different 

OP Same(0.98) Different Different Same 

Figure 4.16 - KS Results for the Spatial Distribution at a Confidence 

Le\'CI of 95% 
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4 .2.2 40 pixels/mm 

4.2.2.1 Image F earures 

Five images of a resolution of 40 pixels/mm were captured of each of the samples of 

different pitching levels. These images were all 512 x 768 in size and covered an area of 

242.4 mm2. This provided five images at each of the four pitching levels to work wi th. 

For each of the images the image feawres were calculated using "Image" and "Excel" and 

the area and nearest neighbour di stance distributions were also noted. Graphs of the 

image features as a funct ion of pitching level are shown in Figures 4 .1 7 to 4.26 below. 

These graphs show the mean and uppe r and lower bounds (ie ±3 standard deviations) of 

the five feawres after the brgest and smallest fc;1tu re values for the five images have been 

discarded. This removes the outliers. 

This analysis will indic:He the variahility or e;1ch fe:1ture. It will also show if there are any 

stati stical differences between the features for different pitching levels. 
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From the above figures there exist no trends for the image features as a function of th e 

pitching level although some statistical differences between differing pitching levels are 

evident. 

For the inertia, distance factor, and the average nearest neighbour distance features the 

underpitched anode is statistically different from the slightly overpitched anode. The 

weighted area feature for the underpitched anode is statistically different from the good 

anode and the correlation feature for the good anode is statistically different from all the 

other pitching levels . These results could be useful in di scriminating the anodes from one 

another. 

4.2.2.2 Area and Spmial Discrihwions 

For each of the images the area and nearest neighbour distance distributions were noted. 

The Kolgomorov-Smirnov (KS) tests were again performed on the area and nearest 

neighbour distance (spatial) distributions to see if the distributions for differing pitching 

levels were different. 

As five images were captured for each pitching level KS tests were performed to see if the 

area and spatial distributions were the same for images of the same pitching level as well 

as seeing if the distributions were different for images of differing pitching level. The 
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results of the KS tests at a 99% level of confidence for the area distribution are shown in 

Figure 4.27 below. 

Ul U2 U3 I U4 us GI G2 G3 G4 GS S 1 S2 S3 S4 S5 01 02 03 04 05 
~ 

Ul 0 0 0 0 0 1 () () () 0 0 0 0 0 0 () 0 0 1 1 

U2 0 0 0 0 0 I () () () () () 0 0 () 0 0 0 0 1 0 

U3 0 0 0 0 0 1 () () () () () () () 0 () 0 0 0 1 1 

U4 0 0 0 0 () I () () () 0 () () () 0 I 0 0 0 1 1 

us 0 0 0 () () I () 0 0 () () () () () 1 0 0 0 I 1 

Gl 1 I I I I () I I I I I () I I 0 () 0 0 0 0 

G2 0 0 0 0 0 I () 0 0 0 0 0 0 0 0 0 0 0 0 I 

G3 0 0 0 0 () I () 0 () () () 0 0 0 0 0 0 0 0 1 

G4 0 0 0 0 0 I () 0 () 0 () 0 0 0 0 0 0 0 1 I 

GS 0 0 0 0 0 1 () 0 0 0 0 0 0 0 0 0 0 0 1 1 
= 

SJ 0 0 0 0 () I () 0 () () 0 () () 0 0 0 0 0 1 0 

S2 0 0 0 0 0 () () 0 0 () () () 0 0 0 0 0 0 1 0 

S3 0 0 0 0 0 1 () 0 () () 0 () () 0 0 0 0 0 1 0 

S4 0 0 0 0 0 1 () 0 () () 0 () () () 0 0 0 0 0 0 

S5 0 0 0 1 1 0 () () () () 0 () () () 0 0 0 0 0 0 

01 0 0 0 0 0 () () () () () 0 0 0 0 0 0 0 0 0 0 

02 0 0 0 0 0 0 0 0 0 0 0 () 0 0 0 0 0 0 0 0 

03 0 0 0 0 0 0 () 0 () 0 0 () 0 0 0 0 0 0 1 0 

04 1 1 1 1 1 0 () () I 1 I 1 1 0 0 0 0 1 0 0 

05 1 0 1 1 1 () 1 I I 1 () () () 0 0 0 0 0 0 0 

Figure 4.27 - KS Results for the Area Distribution 
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Figure 4.28 - KS Results for the Spatial Distribution 
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and 

0 = Overpitched 

'O' signifies the distributions are the same 

'1' s ignifies the di s tributions are different 

Figure 4.27 shows that the area di stribution for eac h image te nds to be the same as any 

other image. Three of the images stand out as being diffe rent: G 1, 04 and 05. T his is 

because these images have more larger or smaller voids. Overal l, the area distributions of 

the voids does not vary with pi tch ing leve l in a consiste nt manner. 

The results of the KS tests at a 997c level of confidence for the nearest neighbour distance 

distributions are shown in Fig ure 4.28. 

For the spatial di s tribution. all o f the im:1gcs from the same pitching level are a ll the same 

but images from d iffe rent pitching levels are not a ll di ffere nt. Some of the anode types 

diffe r markedl y. F or example the im:1ges from th e good :111ode are nearly a ll diffe re nt 

from the images fro m the unckrpitched anode. These results can be summarised in figure 

4.29 where th e number i11 each cell corresponds to the number of differences ( l 's) 

be tween pitch ing levels divided by 25 (t he total number of KS tes ts performed be twee n 

each p itching level). 

UP Goo d SOP OP 

UP () 0.8 8 0.48 0.24 

Good 0.88 () 0.28 0.52 

SOP 0.48 0.28 0 0.1 2 

OP 0.24 0.52 0.12 0 

Figure 4.29 - Summarised KS Result s for the S patial Dis tribution 

It can be seen from fi g ure 4.29 tha t the h igher the number then the greater the difference 

be tween the correspond ing spa tial di stri bu tions. T h is does no t te ll w hat values a re 

sig nificant o r no t. ls the va lue o f 0.12 fo r the SOP/O P test s ig nificant a t a 99% le ve l o f 

confide nce? To answer thi s questio n , the area and nea rest neig hbour di s tance 

d istributions for the fi ve images o f eac h pitching level were pooled together. This will 

result in o ne a rea and nearest ne ig hbour distance distri bution for eac h pitching level. 

The results of thi s ana lys is for a 99% leve l of confide nce is show n in fi gures 4.30 a nd 

4.31. 
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UP Good SOP OP 

UP Same Different Different Different 

Good Different Same Same Same 

SOP Different Same Same Same 

OP Different Same Same Same 

Figure 4.30 - Pooled KS Results for th e Area Distribution at a 99 % Level 

of Confidence 

UP Good SOP OP 

UP Same Different Different Different 

Good Different S;1me Different Different 

SOP Different Different Same Same 

OP Different Different Same Same 

Figure 4.31 - Pooled KS Result s for the Spat ial Dis tribution at a 99 % 

Level of Confidence 

Figures 4.30 shows that the area distribut ion for the underpitched anode vanes 

significant ly from the other anodes. Th is shows that the KS test for the area distributions 

could be used to discriminate underpitched anodes. 

Figure 4.31 shows that the spatial distributions for the pitching levels are all significantly 

different from each other at the 99% level of confidence, except for the slightly 

overpitched anode with the overpitched anode. The KS ratio for this test was 0.98 so the 

two anodes are almost significantly different from each other. This KS ratio of 0.98 could 

be expected as there is only a little difference between the slightly overpitched and 

overpitched anodes with respect to the amoum of pitch present. This ratio of 0 .98 also 

corresponds to the number 3 in figure 4.29, so the assumption that the higher the number 

then the more different the pitching levels ~u·e seems valid. 

The KS ratios were adjusted to a 95% confidence level and the results are shown in 

figures 4.32 and 4.33. 
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UP Good SOP OP 

UP Sarne Different Different Different 

Good Different Sarne Same Different 

SOP Different Sarne Same Different 

OP Different Different Different Same 

Figure 4.32 - Pool ed KS Results for the Area Distribution at a 95% Level 

of Con fi clence 

UP Good SOP OP 

UP Same Different Different Different 

Good Differem Sarne Different Different 

SOP Differen t Different Same Different 

OP Differen t Different Different Same 

Figure 4.33 - Pooled KS Result s for the Spntial Distribution at a 95 % 

Level of Confidence 

Lowerin g the confidence leve l increases the discriminating power of the KS test. The 

overpitched anode now has a significantly different area distribution from all the other 

anodes. The KS test at this confidence level can only di scriminate overpitched or 

underpitched anodes from good or sligh tly overp itched ones. 

The lower confidence leve l has increased the KS ratio of the overpitched/slightly 

overpitched KS test from 0.98 to 1. 18, making it significant. This now means any anode 

of a particular pitching level has a significantly different spatial distribution from any 

anode of a different pitching level, at a 95% confidence level. 

Overall the KS test at 40 pixels/mm resolution indicates that the spatial distribution of the 

voids varies according to pitching level. 
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4 . 3 Changes in Forming Conditions 

4.3.1 IOpixels/mm 

4.3.1.1 Image Fcmurcs 

Images of a resolution of IO pixels/mm were captured of each of the prepared samples 

formed under d iffering condi tions. At this resolution only one image was able to be 

captured for each fom1ing condit ion. These images were each 512 x 512 in size, covering 

an area of 2324.2 mm2. Thi s provided 6 irn:tges, one for each set of form in g conditions, 

to work with . 

The image features of each image were calculated using "Image" and "Excel" , and the 

area and nearest ne ighbou r distance di st ribut ions were also noted. Plots of the image 

features as a function of the fo rming conditions are shown in Figures 4.34 to 4.43 below. 
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Figure 4.36 - Inertia vs Forming Conditions 

50 



Homogeneity 

0.09 

0.085 
IJ 

>-

Cl) 0 .08 [J 
C: [] 
Cl) 

0.075 ll 0) 

0 

E 
0 0 .07 ... C 

I 

0 .065 ... 

0.06 7 

r--- m C") l{) LO 
"'1' "'1' l{) l{) "<J' LO 

~ 

© © © © @ @ 
l{) l{) l{) l{) l.{) l{) 

N N "<J' "<J' r--- r---

Form ing Condition s 

Figure 4.37 - llomogcnc ity ,·s Fo rmin g Co nditions 

Correl at ion 

0 .75 I 

0.745 

0 .74 
C: 
0 0 .735 

C 
IJ ... 0.73 ro 

Cl) 0 .725 [J ... ... 
0 

0 .72 
() 0 . 71 5 rn 

0. 71 

0 .705 
0.7 

r--- m C") l.{) l.{) 

"<J' "<J' If') If') ~ U") 

@, @, @, @, @ @, 
If') If') If') U") I.() l{) 

C\J C\J "'1' "1' r--- r---

Forming Conditions 
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Figure 4.39 - Area Fact o r ,·s Form ing Conditions 
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Figure 4.40 - Distance Factor vs Forming Conditions 

52 



Average Void Area 

0. 1 05 I] 

Cll 0. 1 
<l> ... 

0 .095 ~ [J 

"O 0 .09 
0 

Cl 

> 0 .08 5 ll 

<l> 0 .08 
Ol 

0 .075 Cll m ... 
<l> 

0.07 > 
~ 

0 .065 

0 .06 
r-- (Yl C') l{) l{) 

v v l{) l{) v l{) 

~ ~ ~ 

@; © @; © © @; 
l{) l{) l{) l{) l{) l{) 
(\J (\J v v r-- r--

Forming Conditions 

Figure 4.41 - Average Void Area vs Forming Conditions 
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Figure 4.42 - \Veighted Area vs Forming Conditions 
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Figure 4.43 - Average Ne~rcst Neighbour Dist~ncc vs Forming Conditions 

For the energy, homogeneity, and average area plots the respective image fe:m1res ri ses as 

the temperature ri ses for each of the three vibration times (25s, 45s, and 75s). This is a 

useful result as a high value in any of these features in a prepared sample could signify a 

higher forming temperature. 

Only the correlation plot shows any trend wi th the vibration time. If the average 

correlation is taken for each vibrat ion time then a downward trend is observed. This is a 

useful result as a high correlation value in a prepared sample cou ld signify a smal l 

vibration time. 

If the sample from the 25@ 147 fo1111ing cond ition was anomalous in some way, then the 

inertia and weighted area plots exhibit a systematic trend with the forming conditions. 

4.3. 1.2 Area and Sparial Discrihwions 

For each of the forn1ing conditions the area and nearest neighbour distance distributions 

were noted. This was done to perform the Kolgomorov-Smirnov (KS) tests as outlined 

earlier. These tests will determine if the area and spatial distributions of the voids vary 

with the fom1ing conditions. 

The KS tests were perfom1ed at a 99% confidence level between the six different forming 

conditions for the area distribution and the results are shown in figure 4.44 below. 
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25 @ 147 25 @ 149 45 @ 15 3 45 @ 155 75@145 175 @ 151 

25 @ 14 7 Same Same Same Same Same Same 

25 @ 149 Same Same S:une Same Same Sarne 

45 @ 15 3 Same Same Same Same Same Same 

45 @ 155 Same Same Same Same Same Same 

75@145 Same Same Same Same Same Same 

75@ 151 Same Same Same Same Sarne Same 

Fi gure 4.4~ - KS R('sult s for the Area Oistributi on nt a 99 % Le\'el of 

Co n fi cl (' 11 <.:e 

This table shows that the area distri bution of the voids does not change at 10 pixels/mm 

resolution according to the fo1rn ing conditions. 

The KS tests were pe1fom1cd at a 99% confidence level bet,,·cen the six different fom1ing 

condit ions for the nea rest neighbour di stance dis tribution and the results are shown in 

figure 4.45 below. 

25 @ 147 25 @ 1~ 9 45@153 45 @ 155 7 5 @ 145 75 @ 151 

25@147 Same Different Different Different Different Sarne 

25@149 Different Same Same Different Same Different 

45@153 Different Same Same Different Same Different 

45@155 Different Different Different Same Different Sarne 

75@145 Different Same Same Different Same Different 

75@151 Same Different Different Same Different Same 

Figure 4.45 - KS Results for the Spatial Distribution at a 99% Level of 

Confidence 

From the above data, the temperature change associated with each of the vibration times 

results in a significantly different spatial distributions. This could be useful in detecting 

forming temperature changes however there are no consistent differences between the 

spatial distributions of anodes with differing vibration times. 
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The KS ratios were adjusted for a 95% leve l of confidence and the results are shown in 

figures 4.46 and 4.47. 

l 25 @ 147 25 @ 149 45@153 45 @1 55 75@145 75@151 

25@147 Same Same Same Same Same Different 

25 @ 149 Same Same Same Same Same Same 

45 @ 153 Same Same Same Same Same Same 

45 @ 15 5 Same San,e Same Same Different Same 

75@145 Same Same Same Different Same Same 

75@151 Different Sarne S:1me Same Same Same 

Figure 4.46 - KS Results for the Area Distribution at a 95 % Level of 

Confidence 

25 @ 147 25@149 45@153 45 @ 155 75@145 75@ 151 

25@147 Same Different Different Different Different Same 

25 @ 149 Different Same Same Different Same Different 

45 @ 153 Differen t Same Sarne Different Same Different 

45 @ 155 Different Different Different Same Different Same 

75@145 Different Same Same Different Same Different 

75@151 Same Different Different Same Different Same 

Figure 4.47 - KS Results for the Spatial Distribution at a 95 % Level of 

Con ficl ence 

The lower confidence level has made the area distribution s of the 25@147 forming 

condition significantly different from the 7 5@151 forming condition, and the 45@155 

forming condition is now significantly different from the 75@145 forming condition. 

The lower confidence level has not changed the results for the spatial distributions. 

56 



4.3.2 40 pixels/mm 

4.3.2.1 Image Features 

Ten images were captured at 40 pixels/mm resolution for each of the different forming 

condi tions. These images were all 512 x 768 in size and covered an area of 240.4 mm2. 

This provided ten im ages per forming condition to analyse, a total of 60 images. 

For each image, the im age features were calculated using "Image" and "Excel" and the 

area and nearest neighbour distance distributions were also noted. Graphs of the im age 

feat ures as a function of the forming conditions are shown in Figures 4.48 to 4.57 

below. The graphs show the mean and upper and lower bounds (ie ±3 standard 

deviations) after the two larges t and two smallest features of the ten images have been 

discarded. This removes any outliers and possible anomalies from consideration. 

This analysis will indicate the amount of variability each of the features has. It will also 

show if there are any statistical differences between the features for different forming 

conditions. 
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Figure 4.48 - Energy Spread vs Forming Conditions 
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Entropy Spread 
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Figure 4.49 - Entropy Spread YS Forming Conditions 
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Figure 4.50 - Inerti:.1 Spread YS Forming Conditions 
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Area Factor Spread 
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Figure 4.53 - Arca Factor Sprea d vs Forming Conditions 
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Figure 4.54 - Distance Factor Spread vs Forming Conditions 
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Average Void Area Spread 
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Figure 4.55 - r\ verage Arca S prea d , ·s Forming Conditions 
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Figure 4.56 - vVeighted Area Spread vs Forming Conditions 
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Average Nearest Neighbour Distance Spread 
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Figure 4.57 - Average Nearest Ncighbou r Distance Spread vs Forming 

Conditions 

For the energy, and inertia plots the re spective image feature mean marginally rises as the 

temperature rises for each of the three vibration times (25s, 45s, and 75s) . This is a 

useful result as a rise in any of these features in a prepared sample could signify a 

temperature increase during the vibration pressing. Only the inertia plot shows any 

significant difference between forming conditions, in as much as the 25@149 value is 

significantly different from the 25@147 and 75@145 values. 

None of the plots showed any trends between the image feature and the vibration time. 

4.3.2.2 Area and Spatial Distrihwions 

For each of the images the area and nearest neighbour distance distributions were noted. 

The Kolgomorov-Smirnov (KS) tests were again performed on the area and nearest 

neighbour distance (spatial) distributions to see if the distributions for differing forming 

conditions were different. 

As ten images were captured for each forming condition, KS tests were performed to see 

if the area and spatial distributions were the same for images of the same forming 

condition as well as seeing if the distributions were different for images of differing 

forming conditions. 

The KS results for the area distribution at a 99% level of confidence are summarised in 

Figure 4.58 where the number in each cell corresponds to the number of area distribution 
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differences (l's) that individual images had be tween the respective forming conditions 

divided by 100 (the total number of KS tests perfonned between each forming condition). 

25@147 25@149 45@153 45@155 75 @145 75@151 

25@14 7 0.05 0. 33 0.17 0.22 0.16 0.46 

25@149 0.33 0.01 0. 18 0.32 0.10 0.13 

45@153 0.17 0. I 8 0.12 0.28 0.10 0.34 

45@155 0.22 0.32 0.28 0. I 8 0.22 0.34 

75 @ 145 0. 16 0.10 0.10 0.22 0.03 0.19 

75 @ 151 0.46 0. 13 0.34 0.34 0. I 9 0.12 

Figure 4.58 - Summarised KS Results for the Area Distribution at a 99% 

Level of Confidence 

The KS results for th e nea rest ne ighbour distance (spatial) di stribution at a 99% level of 

confidence are summarised in Figure 4.59. 

25@147 25@149 45@ 153 45@155 75@145 75@151 

25@147 0.05 0.23 0. 17 0.28 0.28 0.41 

25@149 0.23 0.11 0.20 0.34 0.13 0.19 

45@153 0. 17 0.20 0.12 0.33 0.23 0.33 

45@155 0 .28 0.34 0.33 0.22 0.35 0.42 

75@145 0.28 0. I 3 0 .23 0.3 5 0.18 0.29 

75@151 0.41 0.19 0.33 0.42 0.29 0.09 

Figure 4.59 - Summarised KS Results for the Spatial Distribution at a 

99 % Level of Confidence 

As seen earlier these results by themselves mean nothing as we do not know which 

values are significant or not. The large numbers on the leading diagonal (intersample) KS 

tests would indicate there is a large amount of variation between the samples. This 

indicates that there may need to be more samples taken to get less variation. The area and 
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nearest neighbour distance distributions of the ten images per forming condition were 

pooled together and this resulted in one area and one nearest neighbour distance 

distribution for each forn1i ng cond ition. 

The results of the KS tests at a 99% leve l of confidence on th ese distributions is shown in 

Figures 4.60 and 4.61 below. 

25@]47 25@]49 45 @ 153 45 @ 155 75 @ 145 75@151 

25@]47 Same Different Diffcrem Same Different Different 

25@149 Different Same Different Differen t Same Same 

45 @ 153 Different Different S:m1e Same Same Different 

45 @ 155 Same Differem Same Same Same Different 

75 @ 145 Different Same S:1me Same Same Different 

75 @ 151 Different Same Different Different Different Same 

Figure 4.60 - Pooled KS Result s for the Arca Distribution at a 99 % Level 

of Co n fi cl ence 

25-147 25-149 45-153 45-155 75-145 75-151 

25@147 Same Different Same Sarne Different Different 

25@149 Different Same Same Same Same Different 

45@153 Same Sarne Same Same Same Different 

45@155 Same Same Same Same Different Different 

75@145 Different Same Same Different Same Same 

75@151 Different Different Different Different Same Same 

Figure 4.61 - Pooled KS Results for the Spatial Distribution at a 99% 

Level of Confidence 

From the above data, it seems the KS test at a 99% level of confidence does not 

discriminate between the anodes in any useful manner. The temperature change associated 

with each of the vibration times does not result in significant differences in measured area 
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or spatial di stribution s. There are also no consistent differences between the area and 

spatial distribution s of anodes with differing vi bration times. It mu st be noted here that 

the leading diagonal for borh tables is zero because there is only one set of pooled data for 

each forming condit ion. Thi s means when a KS tes t is performed on two sets of the same 

data the result has to be zero. Thi s accounts for the discrepancies in the leading diagonal 

from the summarised tables (figures 4.58 and 4.59). 

The KS ratios were adjusted for a 95% leve l of confidence and the results are shown in 

figures 4.62 and 4.63. 

25 @ 147 25@149 45 @ 153 45@155 75@145 75@151 

25@147 Same Differem Different Same Different Different 

25@149 Different Same Different Different Di ffe rent Same 

45@153 Different Different S:1rne Same Same Different 

45@155 Same Different Same Sarne Same Different 

75@145 Different Different S:1me Same Same Different 

75@151 Different Same Different Different Different Same 

Figure 4.62 - Pooled KS Results for the Area Distribution at a 95% Level 

of Confidence 

The lower confidence level does not lead ro any new conclusions. 

Overall it mu st be concluded that at a resolution of 40 pixels/mm, the measured area and 

spatial di stribution of the voids does not change cons istentl y with the forming conditions. 
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25-147 25-149 45-153 45-155 75-145 75-151 

25@147 Same Different Different Sarne Different Different 

25@149 Different Same Same Same Sarne Different 

45@153 Different Same Sarne Same Different Different 

45@155 Same Same Sarne Sarne Different Different 

75@145 Different Same Different Different Sarne Different 

75@151 Different Different Different Different Different Same 

Figure 4.63 - Pooled KS Results for the Spntial Distribution at a 95% 

Level of Confidence 

4.4 l\Iodelling 

An attempt was made to model the fanning conditions (ternperature and time) from the ten 

image features. The image features of a series of images at 10 and 40 pixels/mm were 

noted and these used to cre:lte a model of the forrning temperature and vibration time 

using the image features as predictors. 

The models were created using "Mini tab", a widely used statistica l analysis package, but 

the results were limited . The best linear models h:1d an R-squared (adj.) result of around 

20%. This implies that a linear model was not appropriate. Lack of time prevented any 

attempts at extending the model to quadratic terms and allowing interaction of variables. 

Another potential problem was the bck of replicate data necessary to test the fit. 

Any modelling of the forming conditions from the image features is future work. 
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5 CONCLUSIONS AND FUTURE WORK 

For the pitching level changes at 10 pixels/mm the following may be 

concluded: 

The inertia, homogeneity , and distance factor image features vary systematically 

with the pitching level. 

The measured area histogram of the voids does not vary with changes in the 

pitching level at a 99% level of confidence. At the 95% level of confidence the 

measured area histogram of the underpitched anode differs significantly from that 

of the good anode and the slightly overpitched anode. 

The spatial distribution of the voids of the good anode was significantly different 

from the overpitched anode at a 99% level of confidence. At the 95% level of 

confidence the spatial distribution of the voids of the slightly overpitched anode 

was also significantly different from the overpitched anode. 

For the pitching level changes at 40 pixels/mm the following may be 

concluded: 

None of the image features varied systematically with the pitching level. 

The measured area histogram of the underpitched anode varies significantly from 

the measured area histograms of the other anodes at a 99% level of confidence. 

This result is useful for discriminating the underpitched anode from the others. At 

the 95% level of confidence the overpitched anode also becomes significantly 

different from all the others . The KS test at this level of confidence now 

discriminates overpitched and underpitched anodes from better quality ones. 

The spatial distributions of the anodes are all significantly different from each 

other at a 99% level of confidence other except the slightly overpitched anode is 

the same as the overpitched anode with a KS ratio of 0.98. At the 95% level of 

confidence this KS ratio increased and hence all the anodes of any pitching level 

now have significantly different spatial distributions from any other pitching level. 

For the forming condition changes at 10 pixels/mm the following may be 

concluded: 

• The energy, homogeneity, and average void area image features rise when the 

forming temperature was raised and the vibration time kept constant. 

• The correlation image feature varies linearly with the vibration time. 
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The measured area histogram of the voids does not vary with changes in the 

forming conditions at a 99% level of confidence. At the 95% level of confidence 

the measured area histogram of the 25@147 forming condition differs from the 

75@151 measured area histogram. The measured area histogram of the 45@155 

forming condition also differs from the 75@145 measured area histogram. 

The spatial distribution of the voids changes significantly at a 99% level of 

confidence when the forming temperature rises at a constant vibration time. This 

result does not change for a 95% level of confidence. 

For the forming condition changes at 40 pixels/mm the following may be 

concluded: 

The energy, and inertia image features rise slightly when the forming temperature 

was raised and the vibration time kept constant. 

The measured area histogram s and spatial distributions of the voids vary 

inconsistently with the changes in the forming conditions at both 99 % and 95 % 

level of confidence. 

Overall the results for the changing pitching levels for the 40 pixels/mm resolution are the 

most promising. It appears that the methods outlined in this work will successfully detect 

changes in pitching level but not changes in the forming conditions. 

Better results may occur if more images' area and nearest neighbour distance distributions 

are pooled for the KS tests . This work used a maximum of ten images from a small 

individual sample. More images from more individual samples may give better 

discrimination results. It must be noted that this work has only shown that differences in 

the area and spatial distributions of the voids actually exist. 

The following image processing routines provide a useful base for any future follow-on 

projects and related studies: 

• Statistical Texture Analysis [3,4,5,6] 

• Rank and Range Filters [14] 

• Area/Distance Factors 

• Weighted Area 

• Nearest Neighbour Analysis (Spatial Distribution) [9] 

• Circularity 

• Connectivity 
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Texture Primitives [ 15) 

These routines have the potential to allow the necessary di scrimination of anodes with 

different pitching levels or forming conditions to be made. 

More work is necessary in the modelling of the forming conditions, along with physical 

measurements such as density, resistivity etc., from the image features. Experimental 

design using the forming conditions and measuring the images features could be useful in 

modelling the process . 
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APPENDIX A - User Manual 

Introdu ction 

Before one starts with this package one shoL1 ld be familiar with standard "Irnagel.44" 

[11 ,12) . The User menu , shown in figL1re 1, adds new analysis packages such as 

statistical texture ana lysis and neigh bour analysis to "lmagel.44" . Other features such as 

a rank and range filte r, and variolls me:1sures such as circularity, area and distance 

factors, and weighted area have also been added. Firs t of all the four sta ti stical texture 

methods (SGLDM ... , GLDM ... , GLRL:\1..., and NGLDM ... ) [3,4,5,6] w ill be 

explained then the two suh-menus (Filters and l\le:-is ures) will be described. Finally 

the macro commands fo r the User menu will be described . 

N. Il. It is impera tive th:-it a region of int eres t is chosen on any image 

before :-iny of the st:-iti s tic:-il t ex ture analysis commands are chosen. 

These statistical texture :1n:1lysis " ·ill NOT work properl y unless a 

reg ion of interes t is chose n fir st. ff th e use r wants to analyse the 

whole image th en th e whole im:1 gc must be se lected using Select All 

in th e Ed it m en u or another nppropriate m ethod. 

SGLOH... :3€: t 
GLOH... :~:2 
GLRLH... :3€:3 
NGLDH... :3€:4 

Filters ~ 

Measures ~ 

Figure I User l\lenu 

Statistical Texture Analysis 

Statistical texture analysis f3 ,4,5,6l is a powerful technique that is used to characterise 

texture features in an image in a quantitati ve, consistent and objective way. The texture of 

an image is concerned with the spatial distribution of the gray levels in the image. This 

distribution can be detem,inistic or stochastic in the exrreme as shown in figure 2. 
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Determinis tic 

Stochas tic 

Figure 2 Texture Types 

Deterministic tex tures are best analysed using structural methods such as placement rules 

and tree diagrams while stochastic tex tures such as carbon anodes are best analysed 

statistically. These stochastic textures can be analysed stati stically using four different 

intermediate matrix methods: 

1 . Spatial gray level dependency method, SGLD1vl f3] 

2. Gray level difference method, GLDM 141 

3. Gray level run length method, GLRLM 151 

4. Neighbouring gray level dependency method. NGLDM [6] 

The intermediate matrices calculated from each of the above methods describe in coded 

form the spatial relationships between the gray levels in the image. These intermediate 

matrices allow the calculation of texture features to be made which in turn attempt to 
describe the texture in a meaningful way. 
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Spatial Gray Level Dependencv Method 

The spatial gray level dependency method l 3 J is the most widely used method and is 

based on the estimation of the second order joint conditional probability density functions 

J(i,j,d,a) where di s the intersample spacing and a is the direction (ie 0°, 45°, 90°, 135°). 

This is illustrated in fi gure :_:;_ 
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Figure 3 - Direc tions 

f(iJ,d,a) is the probability of goi ng from gray le,-el i to gray level j , in di stanced between 

the two, and in direction a (0 °, 45 °, 90 °, and 135 °). If there are Ng gray levels in the 

image then the in tem1ediate matrix P(i.j.d,a) is N~ x Ng in size. 

The above method calculates four P(i,j ,d,a) intermediate matrices, one for each direction 

a . For example, the simple image in figure 4 which has 5 gray levels (0-4), will result in 

four 5 x 5 matrices, one for each direc tion a . The resulting intem1ediate matrix for the 

horizontal direction is shown in figure 5. 
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Figure 4 - Simple Image 
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The underscored 4 in the P(i,j,l ,0°) matrix above is the number of times a gray level O is 

next to the same level in the i1n:1ge in the horizontal direction. 

The underscored 1 in the P(i ,j,l ,0°) matrix above is the number of times gray level O is 

next to gray level 2 in the image in the hor·izontal direction. 

The four P(i,j,d,a) matrices are normalised by a normali sing function dependant on the 

size of the region of interes t (ROI) in the chosen image to give the four intermediate 

matrices: f( iJ,d,0 °),f( i,j ,d,45 °), f( i,j ,d, 90 °), and f( i .j.d, 135 °). 

Haralick et al. [3] proposed various features that can be calcub ted from the these 

f(i,j,d,a) matrices. These features are energy, entropy, inertia, homogenei ty and 

correlation. 

• Energy is a measure of the homogeneity of the image. In a homogeneous image 

the energy will be high and for a nonhornogeneous image the energy will be low. 

• Entropy is a meas ure of the complexity of an image. The more complex an image 

is the higher the entropy is. 

• Inerti a is a measure of th e amount of local variations present in the image. The 

more local variations (contrast) present the higher the inenia. 

• Homogeneity is a measure of the degree with which similar gray levels tend to be 

neighbours. 

• Correlation is a measure of gray level linear dependencies. 

When SGLDM ... is chosen from the User menu, "Image" displays a dialogue box 

which asks for an intersample distance d. "Image" uses this distance to calculate the 

above features from the chosen region of interest in the image. This dialogue box is 

shown in figure 6. In order to put the SGLDM results into the results window, one must 

choose the Texture option in the options dialogue box first as shown in figure 7. This 

dialogue box appears when Options ... is chosen from the Analyze Menu as shown in 

figure 8. This will display the results for each direction in tabular form in the results 
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window when the Show Results command is chosen from the Analyze menu. This 

results window is shown in figure 9. 

Distance d (SGLDM): 

Figure 6 - SGLD:\I Distance 
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This table has been put into the results window which can then be saved as an "Excel" 

text file by choosing Save As .. from the File menu and saving as measurements . 

This is shown in figure 10. 
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Doing more texture analysis will add tabks to the results window so when the results 

window is next saved it wil l include all work done up to then. The window and hence the 

results to date can be c leared at will by choosing Reset from the Analyze menu, as 

shown in figure 11. 
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Figure 11 - Reset 
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Grav Level Difference M ethod 

The gray level difference method [ 4J works on th e gray level differences between two 

adjacent pixels separated by a distanced. Let f(x, y) be the digital image andf(x,y) = 
/f(x,y)j(x+flx , y+L\y)/ where Llx and L\y are integers giving the displacement, d. 

Let P' be the probability density function off'. If there are Ng gray levels in the image 

then P' has the form of a Ng dimensional vector whose itlz component is the probability 

thatf(x,y) will have value i. It is simple to compute P'(i) fromf by counting th e number 

of times each value of f(x ,y) occurs. 

The above method is calculated for each of th e four basic directions a as shown in figure 

3. 

Weszka et al. [ 4] proposed various features that can be calculated from the four P'(i) 

matrices. These features are con1ras1 (CON), :111 gular second moment (ASM), entropy 

(ENT), mean (MEAN) and inverse different moment (IDM). These features attempt to 

describe the texture numerically. 

The contrast is th e second moment abouI P'(i). This is greatest when the visual 

contrast in the image is large . 

The angular second moment is smallest when P'(i) are all as equal as possible and 

large when some values are high and some low. 

The entropy is largest for equ:tl P'(i) and smallest when they are very unequal. 

• The mean is smallest when P'(i) are concentrated near the origin and largest when 

they are far from the origin . 

When GLDM ... is chosen from the User menu , " Image" displays a dialogue box 

which asks for an intersample distanced. "Image" uses this distance to calculate the 

above features from the chosen region of interest in the image. This dialogue box is 

shown in figure 12. In order to put the GLDM results into the results window, one must 

choose the Texture option in the options dialogue box first as shown in figure 7. This 

will display the results for each direction in tabular form in the results window when the 

Show Results command is chosen from the Analyze menu . This results window is 

shown in figure 13. 
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This table has been put into the result s window which can then be saved as an "Excel " 

text file by choosing Save As .. from the File menu and saving as measurements. 

This is shown in figure 10. 

Doing more texture analysis will add tables to the results window so when the result s 

window is next saved it will include all work done up to then. The window and hence the 

results to date can be cleared at will by choosing Reset from the Analyze menu , as 

shown in figure 11. 

Gray Level Run Length Method 

The gray level run length method 15 I is based on calculating the number of gray level runs 

of various lengths in the four basic directions a as shown in figure 3. A gray level run is a 

set of consecutive co-linear pixels of the same gray level. The length of the run is the 

number of pixels in the run. 

The intermediate matrices P(i,j) specify the number of times the image contains a run of 

lengthj, in the given direction, consisting of pixels of gray level i. Let Ng be the number 

of gray levels and Nr be the number of different possible run lengths. 
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Using the image in figure 14, the P( i j) matrix for O O is shown in figure 15. 
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Figure 14 - The Image 
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The underscored 1 means the gray level I has one run of length 3 in the image. 

Galloway [5] proposed various features th at can be calculated from the four P(i,j) 

matrices. These features are long run emphasis (LRE), short run emphasis (SRE), gray 

level nonuniformity (GLNU), run length nonuniformity (RLNU ) and run percentage 

(RPC). These features attempt to describe the texture numerically. 

• 

• 

• 

The long run emphasis gives greater weight to long runs of any gray level. 

The short run emphasis gives greater weight to short runs of any gray level. 

When runs are equally distributed throughout the gray levels the gray level 

nonuniformity is smallest. 

When runs are equally distributed throughout the run lengths the run length 

nonuniformity is smallest. 

• The run percentage is the lower for images with the greatest linear structure. 

When GLRLM ... is chosen from the User menu, "Image" calculates the above features 

from the chosen region of interest in the image. Provided the Texture option has been 

chosen from the options dialogue box, a table similar to that shown in figure 16 will be 

displayed when the Show Results command is chosen from the Analyze menu. 
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Figure 16 - GLRLM Results Window 
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This table has been put into the res ult s window which can then be saved as an "Exce l" 

text file by choos ing SaYe As .. from th e File menu and saving as measurements . 

This is shown in figure 10. 

Doing more texture analysis will add rabies ro the result s window so when the results 

window is next saved it will include all work do ne up to then. The window and hence the 

results to date can be cleared at will by choos ing Reset from the Analyze menu , as 

shown in figure 11. 

Nei!!hbourin!! Grav Level Derendencv Method 

The neighbouring gray level dependency method [6] is directionally independent. The 

intermediate matrix Q(k ,s) is calculated by considering the relationship between a pixel 

and all its neighbouring pixels, at a distance less than or equal to d, at one time instead of 

in one direction at a time. 

For example consider the image in figure 17 which has 8 gray levels 0-7. 
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Figure 17 - The Image 

An intermediate intem1ediate matrix P(ij,d,a) is calc ulated. For the above example thi s is 

calculated on pixel 3,3, which has a gray level of 5, in a neighbourhood of d=I around 

it, with the difference factor, a=zero . Th ere is on ly one pixel in the neighbourhood of 

distance I ( d=I) with a gray leve l of 5 equal ( a=O) to that of pixel 3 ,3. Therefore 

P(3,3 ,J ,0)=(5, l ) where 5 is the gray level and I is the NGLDM number for the pixel 

3 ,3. 

The complete P(i,i, l ,0) for th e image is shown in figure 18. 

(4,3) (5, 2) (3,0) (0, 2) 

(3, I) ( 5, I) (0 , 2) (0,2) 

(0,2) (7, 2) (3.2) (3,3) 

(0,3) (7,2) (7, 2) (3,3) 

Figure 18 - P(i,j,1,0) 

Q{k,s) is the intermediate matrix for NGLDM and is the total number of entries in P that 

have gray level k and NGLDM numbers . 

eg. Q{7,2)=3 because there are 3 entries of (7,2) in the P matrix in figure 18. Therefore 

the Q matrix in figure 19 can be considered as frequency counts of the greyness variation 

of an image. It is similar to the histogram of the image. 
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Fi gure 19 - Q(k,s) 

As shown above Q(7,2) = 3 . 

Sun and Wee [6] proposed various features th at can be calculated from the Q{k,s) matrix. 

These features are sma ll number emphasi s (SNE), large number emphas is (U\TE), 

number nonuniformity (NNU), second moment (SM) and entropy (ENT). These features 

attempt to describe the texwre numericall y. 

• The small number emp hasis is a measure of the fineness of the image. The finer 

the image is the larger the small number emphasis is. 

• The large num ber emphasis is a measure of the coarseness of the image. The 

coarser the image is the larger th e large number emphasis is. 

• The number nonuniforn1ity is related to the coarseness of the image. 

• The second mome nt is a measure of the homogeneity of the image. The larger the 

second moment is th e more homoge neous the image is. 

• The entropy is related to the coarseness of the image. 

When NGLDM ... is chosen from the User menu, "Image" displays two dialogue 

boxes which asks for an intersample distance d, and a difference factor a . "Image" uses 

these numbers to calculate the above features from the chosen region of interest in the 

image. These dialogue boxes are shown in figures 20 and 21. In order to put the 

NGLDM results into the results window, one must choose the Texture option in the 

options dialogue box first as shown in figure 7. This will display the results in tabular 

form in the results window when the Show Results command is chosen from the 

Analyze menu. This results window is shown in figure 22. 
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This table has been put into the results window which c:rn then be saved as an "Excel" 

text file by choosing Save As .. from the File menu and saving as measurements. 

This is shown in figure 10. 

Doing more texture analysis will add tables to the results window so when the results 

window is next saved it will include all work done up to then. The window and hence the 

results to date can be cleared at will by choosing Reset from the Analyze menu, as 

shown in figure 11. 
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The Filters Submenu 

The Filters Sub-menu contains the following items as shown in figure 23: 

1. Rank Filter. .. 

2. Range Filter. .. 

ial Stacks Windows 

·=· ·=· ._, ._. 

SGLDM ... 
GLOM ... 
GLRLM ... 
NGLDM ... 

Figure 23 - Filters Sub-l\lenu 

Rank Filter r 14] 

This menu item perfonns a ra11k filter operatio11 on an image. The user is first asked what 

rank they want done . A ra11k of I is a Minimum filter, a rank of 9 is a Maximum filter, 

and a rank of 5 is a median filter. 

Range Filter 

This menu item perfom1s a ra11ge filter (edge detection) operation on an image. The user 

is first asked what ranks they want performed. 

The Measures Submenu 

The Measures Sub-menu contains the following items as shown in figure 24: 

• Area Factor 

. Distance Factor 

. Weighted Area 

. Neighbour Analysis 19.1 

• Circularity 

• Extend Image (13) 

• Blobs [13] 

• Connectivity 
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• Texture Primitives r1sJ 

ipecial Stacks Windows 

Area Factor 
Distance Factor 
Weighted Area 
Neighbour Analysis 
Neighbour Analysis 2 
Circularity 
fHtend Image 
Blobs 
Connectiuity 
TeHture Primitiues 

SGLDM .. . 
GUJH .. . 
GLRLM .. . 
NGLDM .. . 

Figure 25 . - l\'Je3sures Sub-Menu 

Area Factor (NB - Intended for binary images only) 

l?l ~--

The area factor (AF) measures the spatial and size distribution from th e areas and 

distances between all the voids in an image. For a panicubr image, the AF is calculated as 

follows: 

AF= - I I ~ I ,,· [ "' A j 
N i=I j=I ( d,J) 

=t:-j 

where N is the total number of voids in the image 

Aj is the area of thejth void 

dij is the distance between the ith and jth void 

(1) 

When Area Factor is chosen from the Measures submenu, "Image" calculates and 

displays the area factor for each and every void in the image in the results window, as 

shown in figure 26. In order to get the area factor results into the correct place, the Area 

and Userl options must have been chosen first from the options dialogue box, as shown 

in figure 27. 
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Figure 27 - Options Dialogue Box 

The results in figure 26 show that there were IO voids in the image with the individual 

area factors in the User! column. To get the area factor for the image as a whole, the 

Userl column in the results window is averaged. To do th is, the results window can be 

saved as an "Excel" text file by choosing Save As .. from the File menu and saving as 
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measurements . This is shown in figure I 0. The average of the Userl column can now 

be found using "Excel". 

To do more area factor analysis on other images, the results will need to be cleared by 

choosing Reset from th e Analyze menu, as shown in figure 11. 

Distance Factor (NB - Intended for binary image s only) 

The distance factor (OF) quantifies only th e sp:lli:tl distribution of the voids. This measure 

is the same as the area factor except th at it is nor weighted by the areas of the voids. 

I s [ ·"' I l DF = -I I-2 
N i=I }=I ( dij ) 

;t j 

(2) 
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where N is the total number of voids in the image 

dij is the distance between the irlz and jrlz void 

When Distance Factor is chosen from the Measures submenu, "Image" calculates 

and displays the distance factor for each and every void in the image in the results 

window, as shown in figure 28. In order to get the distance factor results into the correct 

place, the Area and Userl options must have been chosen first from the options 

dialogue box, as shown in fi gure 27 . 
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Figure 28 - Distance Factor Results 

The results in figure 28 show that there were 10 voids in the image with the individual 

distance factors in the User! column. To get the distance factor for the image as a whole, 

the Userl column in the results window is averaged. To do this, the results window can 

be saved as an "Excel" text file by choosing Save As .. from the File menu and saving 

as measurements. This is shown in figure 10. The average of the Userl column can 

now be found using "Excel". 

To do more distance factor analysis on other images, the results will need to be cleared by 

choosing Reset from the Analyze menu, as shown in figure 11. 
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Weighted Area (NB - Intended for bin~u-y images only) 

This is a measure of the volume of the voids in a sample. It is assumed that the larger the 

cross-sectional area of a void in our image of a sample, the larger the volume of the void 

in the original material will be. Each pixel within a void is weighted in proportion to its 

distance from the edge. The weighted area (WA) is calculated by using a MIN filter to 

remove the outermost layer of pixels from all of the voids in the image. The change in 

total area is given a weighting of I for the first layer removed, a weigh ting of 2 for the 

second layer etc, as shown in fi gure 29. The process is repeated until all the voids in the 

image have disappeared, that is eroded to nothing. The area changes for each layer 

removed, along wi th the respective weightings, are summed to give a weighted area for 

the image as a whole. 

L::i.v-s-r- ·1 - ···/·,·\;; io::1 t·1ti rK1 ·1 

, Ill La:::'H-; _ ··.,,'•/~i9 htin9 2 

L·~i ' • .';::.t· ·:, - ·,.1,.:.::-·,..-1 1·1r·1 r·1,·1 -:i 
·- .... ·- · ·- ' I I - · :: . I - :: . ·-' 

Figure 29 - WA Four Layers 

The weighted area can be summarised in the following equation: 

Where 

;V 

WA= IiA, 
i= I (3) 

N is the number of layers in the void 

Ai is the area of the layer 

When Weighted Area is chosen from the Measures submenu, "Image" calculates and 

displays the weighted area for each iteration of the MIN filter in the results window, as 

shown in figure 30. In order to get the weighted area results into the correct place, the 
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Area and Userl options must have been chosen first from the options dialogue box, as 

shown in figure 27. 

D 

1 

2 . 
r, 
..:;, . 

4. 
C" ~·. 
t, . 

7 

·=· ·-·. 
,;, 

rn. 

.. ;.., ·-.,~ 

Results 

77,;, 10 . 000000 

77,;, 10 . 000000 

77,;, 10. 000000 

77910.000000 

77,;, 10. 000000 

77,;, 10 . 000000 

77,;, 10 . 000000 

77910 . 000000 

77,;, 10 . 000000 

779 10 . 000000 

Uset·· 

90!::!. 000000 

165r:, . 000000 

2244.000001] 

24r:,O. 000001] 

2:~:r:,5 . 000000 

1926.000000 

1 '.::9:~: . 000000 

520.000000 

144 . 000001] 

0 . 000000 

·,:•' ·,:::.·::;.·· ... 
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The results in figure 30 show that 10 iterations of the MIN filter were necessary to find 

the weighted areas in the User! column. To get the weighted area for the image as a 

whole, the User! column in the results window is summed. To do this, the results 

window can be saved as an "Excel" text fil e by choosing Save As .. from the File menu 

and saving as measurements. This is shown in figure 10. The average of the User! 

column can now be found using "Excel". 

To do more weighted area analysis on other images, the results will need to be cleared by 

choosing Reset from the Annlyze menu , as shown in figure 11. 

Neighbour Analvsis (NB - Intended for binary images only) 

This routine is where the nearest neighbour di stances are calculated for characterising the 

spatial distribution. The data from this routine is used in "Excel" for the KS tests and to 

find the average nearest ne ighbour distance. 

"Image" calculates and displays the distances to the nearest four neighbours for each void 

in the image if Neighbour Analysis is chosen from the Measures submenu. If 

Neighbour Analysis 2 is chosen, "Image" calculates and displays the 5th, 6th, 7th 

and 8th nearest neighbour distances for each void in the image. 

If the distance to the nearest boundary is closer to the void in question than the distance to 

its first nearest visible neighbour, then the first nearest neighbour distance for that void is 
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zero (ie it doesn't exist). This is because what lies outside the boundary is unknown. If a 

void has no first nearest ne ighbour th en it cannot possibly have a second or third and so 

on. This process can be repeated for higher neighbouring levels. Therefore if the distance 

to the nearest boundary is closer to the void in question than the distance to its second 

nearest vis ible neighbour, then the second nearest neighbour distance for that void is zero 

(ie it doesn't ex ist). This again is because what lies outside the boundary is unknown. If a 

void has no second nearest neighbour then it cannot possibly have a thi rd or fourth and so 

on. 

Each time the neighbo ur level increased, the effec ti ve area over which the neighbour 

analysis was takin g place , gre w smaller. This is because the outer voids were being 

ignored as they were c loser to the boundaries of the image than their nearest visible 

neighbour. These area changes are noted by "J111:1ge" and displayed in the results window 

in the area col umn. These are used in ca lcu lating the R sta tistics. These R statistics can be 

assumed to have no boundary as only voids which have visible neares t neighbours c loser 

than the ne:1. rcst boundary are accounted for. 

When Neighbour An::-ilysis is chosen from the i\Iea s ur es submen u, "Image" 

calculates and di splays the distances to the nearest four neighbours for e:1.ch void in the 

image in the results window, as shown in figu re 31. In order to get the nearest neighbour 

distances into the correct place, the Arca , :X-Y Centre, User!, User2 , User3, and 

User4 options mu st have been chosen firs t from the options dialogue box, as shown in 

fi gure 32. 
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Figure 32 - Options Dialogue Ilox 

The results in figure 31 show rhar rhere were 10 voids in rhe image and rhe four nearesr 

neighbour distances are shown in rhe User!, Uscr2, User3, and User4 columns. To get 

the average nearest ne ighbour disr:rnce, rhe Userl column in the results window is 

averaged. To do th is, the resulr s window can be s:.ived as an "Excel" text file by choosing 

Save As .. from the File menu and saving as measurements. This is shown in figure 

10. The average of the User ! column c:.in now be found using "Excel". Note the large 

number of zeros present in the results. These zeros show many of the voids were closer 

to the edges of the image than the other voids. 

To do more neighbour analysis on other images, the results will need to be cleared by 

choosing Reset from the Analyze menu, as shown in figure 11 . 

Circularity (NB - Intended for binary images only) 

As "Image" measures lengths of the major and minor axes of the best fitting ellipse of a 

void in an image then a measure of the circularity of the voids could be created. In this 

case the circularity is the minor axis divided by the major axis. Therefore a circularity of 

1.0 would indicate a perfectly circular void. The lower the circularity, the longer and 

thinner the void in question. It must be noted that the circularity measure would work best 

on voids with more pixels as the circularity measure could be distorted by extremely small 

voids (<20 pixels). 
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When Circul a rity is chosen from the M ea s ures submen u, "Image" calcula te s and 

d isplays the c irc ula ri ty fo r each and every void in the image in the results window, as 

shown in fi gure 33. In o rder to get the c irc ulari ty results into the correct place , the Area , 

E llipse M aj o r Axis, E llipse Mino r Axi s , and Use rl op tions mus t have been 

chosen first from the opt ions d ia logue box, as shown in fi gure 34. 
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The results in figure 33 show that there were 10 voids in the image with the circularity for 

each void in the User! column. The results window can be saved as an "Excel" text file 

by choosing Save As .. from the File menu and saving as measurements . This is 

shown in figure 10. 

To do more circularity analysis on other images, the results will need to be cleared by 

choosing Reset from the Analyze menu, as shown in figure 11. 

Extend Image 

When the Extend command is chosen from the Measures submenu, "Image" extends 

the second outem1ost layer of pixels in an image to the outem1ost layer. 

Blobs (NB - Intended for binary images only) 

When Blobs is chosen from the l\'leasun~s submenu, "Image" counts and displays the 

number of voids in the image in the results window, as shown in figure 35. In order to 

get the blob count into the correct place, the A ren and Userl options must have been 

chosen first from the opt ions dialogue box, as shown in figure 27. 

Results 

1. 77910 . 000000 10.000000 

Figure 35 - Blob Count Results 

· •. t-···· n-, 
9: "t::.J 

The results in figure 35 show that there were 10 voids in the image with the count shown 

in the Userl column. The results window can be saved as an "Excel" text file by 

choosing Save As .. from the File menu and saving as mensurernents. This is shown 

in figure 10. 
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Connectivitv (NB - In tended for binary images only) 

Connectivity looks at the changes in the number of voids in the image as successive 

layers of pixels are added to the voids using a MAX filter. The final result of the 

connectivity analysis is one single blob where all the original voids in the image have 

been connected together. 

When Connectivity is chosen from the Measures submenu, "Image" calculates and 

displays the number of voids in the image for each iteration of the MAX filter in the 

results window, as shown in figure 36. In order to get the connectivity resul ts into the 

correct place, the Area and User I options must have been chosen first from the options 

dialogue box, as shown in figure 27. 
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Figure 36 - Connectivity Results 
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The results in figure 36 show that 21 iterations of the MAX filter were needed to join the 

voids in the image together. The void count per iteration are shown in the Userl column. 

The results window can be saved as an "Excel" text file by choosing Save As .. from 

the File menu and saving as measurements . This is shown in figure 10. A plot of the 

void count as a function of the number of iteration s of the MAX filter can be plotted in 

"Excel". 

To do more connectivity analysis on other irnages, the results will need to be cleared by 

choosing Reset from the Analyze menu, as shown in figure 11. 

Texture Primitives (NB - Intended for binary images only) 

Thi s method uses various anributes of th e texture primitives (in thi s case the voids) such 

as the area, perimeter, cornp:1c tn ess , eccentrici ty. and direction to analyse the images. The 

area and perimeter of a void are self-expla natory, whereas the compactness is the ratio of 

the square of the perimeter to the area. the eccentrici ty is the inverse of the circularity, and 

the direction is th e angle the ,rnjor axis makes with the horizontal. 

The steps "Image" takes to ca lcul:ite the textu re primitives are as follows: 

• The attributes (area, perirneter, compactness, eccentricity, and direction) are 

calculated for each void in the image 

For each void the four nearest ne ighbours are found 

Primitive attribute co-occurence matrices are constructed for each attribute 

• Second-order statistics are calculated frorn these co-occurence matrices 

The first two steps have been discussed earlier. The final two steps resemble statistical 

texture analysis. 

For each of the attributes, the values are divided into N=l6 intervals. These intervals 

form an N x N co-occurence matrix for each attribute. To construct the co-occurence 

matrix P for the area attribute say, each void and it four neighbours are looked at. If the 

area for a particular void is in interval i and the nearest neighbour's area is in intervalj, 

then we add 1 to P(i,j), the (i.j)th entry of the area co-occurence matrix. Finally, the 

matrix is normalised. 

From the co-occurence n1atrix for each attribute, the following second-order textural 

statistics are calculated: 

• Angular Second Moment (ASM) 

• Entropy (ENT) 
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• Inverse Differen t Moment (IDM) 

• Contrast (CON) 

When Texture Primitives is chosen from the l\Iensures submen u, "Image" calculates 

a table of 20 texture primiti ves, as shown in figure 37. In order to ge t the texture 

primitives resuhs into the correct place, the Pe rimet er , Ellipse Major Axis, Ellipse 

Minor Axis, and Texture options must have been chosen first from the options 

dialogue box, as shown in figure 38. 
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The results in figure 38 show the tex ture primitives table. The results window can be 

saved as an "Excel" tex t fil e by choosing Save As .. from the File menu and saving as 

measu rem en ts . This is shown in figure 10. 

To do more tex ture primiti ve analysis on other images, the results will need to be cleared 

by choosing Reset from the Analyze menu, as shown in figure 11. 

l\lacros [11] 

The following list is all the macro commands I have added to Image Anode to allow one 

to write macros us ing the co1nmands from the User menu. 

*** REMEMBER *** for the Texture Measures to select a Region of 
Interest (RO I) first using the ~ ::h~l1-'\n~ macro command 

***REMEMJ3E R*** for a ll measures to se lect th e appropriate options first 
us ing the §'.!:h c.:1(GJ)1 j O'!J -, macro command 

DoSGLD\it(d) 

DoGLDM(d) 

DoGLRLM 

DoNGLDM(d ,a) 

DoRank(r) 

DoRange(rl ,r2) 

Area Factor 

DistFactor 

fJoWA 

Neighbour 

This macro command does the SG LDM ... command wi th 

an intersample spac ing of d 

This macro command does the GLDM ... command with 

an intersample spacing of d 

Thi s macro command does the GLRLM ... command 

This macro command does the GLDM ... command with 

an intersample spacing of d and a difference of a 

This macro command does the Rank Filter command 

wi th a rank of r 

This macro command does the Range Filter command 

with ranks of r1 and r2 

This macro command does the Area Factor command 

This macro command does the Distance Factor 

command 

This macro command does the Weighted Area command 

This macro command does the Neighbour Analysis 

command 
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Neighbour2 

DoCirc u l~u·i ry 

DoExrend 

DoBlobs 

DoConnectivity 

DoPrimitives 

Shutdown 

This macro command does the Neighbour Analysis 2 

command 

Thi s macro command does the Circularity command 

This macro command does the Extend Image command 

This macro command does the Blobs command 

This macro command does the Connectivity command 

This macro comm:rnd does the Texture Primitives 

command 

This macro command wrns the computer off 
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APPENDIX B - Source Code 

CO n St 

MaxMaxReg ions = 8000; 
type 

Rea! Array = array(O .. MaxMaxRegions] of real ; 
User2Type Rea!Array; 
User3Type RealArray; 
User4Type RealArray; 
UserSType RealArray; 
Texture Results = record 

TF : integer; 
Te xtureData: array[1 .. Max NumData, 1 .. MaxTextHead] of rea l; 
Spacing: integer; 
qw: integer ; 

end ; 
TextureRecordArray = array (0 .. 4000] of TextureResults; 
User1 Type = TextureRecordArray; 
User1 Ptr = "User1 Type; 
User2Ptr 11 User2Type ; 
User3Ptr "User3Type; 
User4P tr = "User4Type; 
UserSPtr "UserSType; 
matphlinetype = array [0 .. 255] of real; 
matph = array [0 .. 255] of matphlinetype ; 
matptr = "matph; 
denfn_Otype = array[0 .. 255] of rea l; 
den fn_Optr = "denfn_Otype ; 
den fn_ 45type = array[0 .. 255] of real; 
denfn_ 45ptr = "denfn_ 45type; 
denfn_90type = array(0 .. 255] of real; 
denfn_90ptr = "denfn_90type; 
denfn_1 35type = array[0 .. 255] of real; 
denfn_ 135ptr = "de nfn_ 135ty pe; 

var 
User1 : User1 Ptr; 
User2 : User2Ptr ; 
User3: User3Ptr; 
User4: User4Ptr; 
Users : User5Ptr; 
a1, d, e, f1, g1, rank, rank h, rank_!, Conn : longint; 
Texture: TextureResults ; 
matphp: matptr; 
denfn_O: denfn_Optr; 
denfn_ 45: denfn_ 45ptr; 
denfn_90: denfn_90ptr; 
denfn_ 135: denfn_ 135ptr; 
width, height, ucol, lcol, urow, !row, gmin, gmax, gwidth: longint; 
wasaccepted: boolean ; 

procedure GetD; {This procedure gets the lntersample spacing for the SGLDM procedure} 

begin 
D := Getlnt('Distance d (SGLDM) :', 0, wasaccepted); 
If wasaccepted then 

exit(GetD); 
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end; 

procedure GetE; {This procedure gets the ln tersample spacing for the GLDM procedure} 

begin 
e := Getlnt('Distance d (G LDM): ', 0, wasaccepted); 
if wasaccepted then 

exit(GetE); 
end ; 

procedure GetG1 ; (This procedure gets the lntersample spacing for the NGLDM procedure} 

begin 
g1 := Getlnt('Distance d (NGLDM):', O, wasaccepted); 
if was accepted then 

exit (GetG1 ); 
end ; 

procedure GetA 1; (This procedure gets the Difference for the NGLDM procedure) 

begin 
a1 := Getlnt(' A (SGLDM) :', 0, wasaccepted); 
if wasaccepted then 

exit (GetA 1 ); 
end ; 

procedure GetR ank ; {Th is procedure gets the ran k for the rank filt er procedure) 

begin 
Rank := Getlnt('Filter Rank? :' , 0 , wasaccepted); 
if wasaccepted then 

exit(GetRank); 
end ; 

procedure GetR ank_h; (This procedure gets the first rank for the range filter procedure} 

begin 
Rank h Getlnt('First Rank?: ', 0, wasaccepted); 
if wasaccepted th en 

exit(GetRank_h) ; 
end; 

procedure GetRank_l; {This procedure gets the second rank for the range filter procedure} 

begin 
Rank_! := Getlnt('Second Rank? :', O, wasaccepted) ; 
if wasaccepted then 

exit(GetRank_l) ; 
end; 

procedure DoSGLDM; {SGLDM) 
label 

100; 
var 

m, lrow: integer; 
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{THIS PROCEDURE READS AN IMAGE LINE BY LINE AND CALCULATES THE MATPH MATRIX FOR 
ZERO DEGREE ANGLE} 

procedure sgldm_zero (var matphp: matptr; D: integer); 
var 

hloc , vloc , i, j: integer: 
R, L: integer; 
line: linetype; 

begin 
with info" .roirect do 
begin 
tor vloc := top to bottom - 1 do 
begin 

getline(left, vloc, width, line) ; 
for hloc := 0 to width - 1 do 
begin 
R := hloc + D: 
L := hloc - D; 
if (R <= wid th - 1) and (L >= 0) then 
begin 
MATPHP"[LINE[HLOC] , LINE[R]] := MATPHP"[LINE[HLOC], LINE[R]] + 1; 
MATPHP" [LINE[HLOC] , LINE[L]] := MATPHP"[LINE[HLOC], LINE[L]] + 1; 

end 
else if (R > width - 1) then 
MATPHP"(LINE[HLOC], LINE(L]] := MATPHP"(LINE[HLOC], LINE[L]) + 1 

else 
MATPHP"[LINE(HLOC], LINE(R]] := MATPHP"(LINE[HLOC], LINE[R]] + 1 ; 

end ; 
end ; 

end ; 
end ; 

{THIS PROCEDURE READS AN IMAGE LINE BY LINE AND CALCULATES THE MATPH MATRIX FOR 
NINETY DEGREE ANGLE} 
procedure sgldm_ninety (var matphp: matptr; D: integer); 
var 

hloc, vloc, up, down, i, j: integer; 
line : linetype; 

begin 
with info" .ro irect do 
begin 
for hloc := left to right - 1 do 
begin 

getcolumn(hloc, top, height, line) ; 
for vloc := O to height · 1 do 
begin 
up := vloc - D; 
down := vloc + D; 

if (up>= 0) and (down <= height - 1) then 
begin 
MATPHP"[LINE[VLOC], LINE[down]] := MATPHP"[LINE[VLOC). LINE[down]] + 1; 
MATPHP"[LINE[VLOC], LINE[up]] := MATPHP"[LINE[VLOC]. LINE[up)] + 1; 

end 
else if (down> height· 1) then 
MATPHP"[LINE[VLOC], LINE[up]] := MATPHP"[LINE[VLOC], LINE[up]] + 1 
else 
MATPHP"[LINE[VLOC], LINE[down]] := MATPHP"[LINE[VLOC], LINE(down]] + 1; 
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end; 
end ; 

end ; 
end ; 

{THIS PROCEDURE READS AN IMAGE LINE BY LINE AND CALCULATES THE MATPH MATRIX FOR 
FOR1YFIVE DEGREE ANGLE} 

procedure sgldm_fortyf ive (var matphp: matptr; D: integer); 
var 

i, j, up, down, I, r: integer: 
begin 
with info".roirect do 
begin 
for i := top to bottom - 1 do 
for j := left to right - 1 do 
begin 

r := j + D; 
I := j - D; 
down:= i + D: 
up = i - D; 

if (r <= ucol) and (up >= lrow) and (I>= lcol) and (down<= urow) then 
beg in 

MATPHP"[mygetpixel(j, i) , mygetpixe l( r, up )] := MATPHP"[mygetpixel(j , i) , 
mygetpixel(r, up)] + 1: 

MATPHP"[mygetpixel (j , i), mygetpixel(I, down)] := MATPHP"[mygetpixel(j, i) , 
mygetpixel(I, down)] + 1; 

end 
else 
begin 
if (r <= uco l) and (up >= lrow) then 

MATPHP"[mygetpixel(j, i), mygetpixel(r, up)] = MATPHP"[mygetpixel(j, i), 
mygetpixel(r, up)] + 1 ; 

if (I>= lcol) and (down <= urow) then 
MATPHP"[myge tpixel(j, i), mygetpixel(I, down)] = MATPHP"(mygetpixel(j, i), 

mygetpi xe l(I, down )) + 1: 
end ; 

end ; 
end ; 

end; 

{THIS PROCEDURE READS AN IMAGE LINE BY LINE AND CALCULATES THE MATPH MATRIX FOR 
135 DEGREE ANGLE} 

procedure sgldm_onethreefive (var matphp: matptr ; D: integer); 
var 

i, j, up, down, I, r: integer; 
begin 
with info".roirect do 
begin 
for i := top to bottom - 1 do 
for j := left to right - 1 do 
begin 

r := j + D; 
I := j - D; 
down:= i + D; 
up:= i - D; 

If (r <= ucol) and (I >= !col) and (up >= !row) and (down <= urow) then 
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begin 
MATPHP"(mygetpi xel(j, i) , mygetpixel(r, down)] := MATPHP"(mygetpixel(j, i). 

mygetpixel(r, down)] + 1; 
MATPHP"[mygetpixel(j, i), mygetpixel(I, up)] := MATPHP"[mygetpixel(j, i), 

mygetpixel(I, up)] + 1 ; 
end 
else 
begin 
it (r <= ucol) and (down <= urow) then 

MATPHP"[mygetpixel(j, i), mygetpixel( r, 
mygetpixel(r, down)] + 1; 

down)] MATPHP"(mygetpixel(j, i). 

it (I>= lcol) and (up>= !row) then 
MATPHP"[mygetpixel(j, i), mygetpixel(I, 

mygetpixel(I, up)] + 1; 
up)] - MATPHP"[mygetpixel(j , i) , 

end ; 
end ; 

end ; 
end ; 

{THIS PROCEDURE CALCULATES THE TEXTURE ENERGY OF A GIVEN SGLD MATRIX} 

procedure texture_energy (var matphp : matptr ; D: integer ; nx: longint ; ny: longint ; 
angle : integer; var energy : real): 

var 
i, j: integer ; 
ri, toten, suben : real; 

begin 
with info".roirect do 
begin 

toten := 0.0; 
case angle of 

O: 
ri := 2 • ny • (nx - d); 

45, 135: 
ri := 2 • (ny - d) • (nx - d); 

90: 
ri := 2 • nx • (ny - d); 

end ; 
for i := gmin to gmax do 
begin 

suben := 0.0; 
for j := gmin to gmax do 
begin 

suben := suben + (matphp"[i, j] • matphp"[i, j]); 
end; 
toten := toten + suben; 

end; 
toten := toten / (ri • ri) ; 

energy := toten; 
end; 

end ; 

{THIS PROCEDURE CALCULATES THE TEXTURE ENTROPY OF A GIVEN SGLD MATRIX} 

procedure texture_entropy (var matphp: matptr; d: integer; nx : longint; ny: long int; 
angle: integer; var entropy : real) ; 

var 
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i, j : integer; 
ri, totent, subent, 110: rea l: 

begin 
with info".roirect do 
begin 

totent := 0 .0; 
subent := 0.0: 
110 := ln(1 0); 

case angle of 
O: 

ri := 2 • ny • (nx - d); 
45, 135: 

ri := 2 • (ny - d) • (nx - d): 
90: 

ri := 2 • nx • (ny - d): 
end ; 
for i := gmin to gmax do 
for j := gmin to gmax do 
begin 
if (matphp"[i, j] <> 0) th en 

subent := subent + (matphp"[i, j] • ((ln (matphp"[i, j] / ri)) I 11 O)); 
end ; 
totent := (subent I ri); 
entropy 

end ; 
end; 

-totent; 

(THIS PROCEDURE CALCULATES THE TEXTURE INERTIA OF A GIVEN SGLD MATRIX} 

procedure texture_inertia (var matphp: matptr; d: integer; nx: longint; ny : longint; angle: 
integer ; var inertia: real) ; 

var 
i, j : integer; 
ri , totinert : real; 

begin 
with info".roirec t do 
begin 

totinert := 0 .0; 
case angle of 

O: 
ri := 2 • ny • (nx - d) ; 

45, 135: 

r i := 2 • (ny - d) • (nx - d); 
90: 

ri := 2 • nx • (ny - d) ; 
end ; 
for i := gmin to gmax do 
for j := gmin to gmax do 
begin 

totinert := totinert + (((i - j) / 1.0) • (i - j) • matphp"[i , j]) ; 
end; 
totinert := totinert / ri ; 
inertia .- totinert ; 

end; 
end; 

{THIS PROCEDURE CALCULATES THE LOCAL HOMOGENEITY OF A GIVEN SGLD MATRIX} 
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procedure texture_hom og (var matphp: matptr; d : integer; nx: longint; ny: longint; angle: 
integer; var homog: real) ; 

var 
i, j: integer; 
ri, result : real; 

begin 
with info".roirect do 
begin 

result := 0 .0; 
case angle of 

O: 
ri := 2 • ny • ( nx - d); 

45, 135: 
ri := 2 • (ny - d) • (nx - d); 

90: 
ri := 2 • nx • (ny - d); 

end ; 
for i := gmin to gmax do 
for j := gmin to gmax do 
begin 

result := result + (matphp"[i, j] / (1 + ((i - j) / 1.0) • (i - j))); 
end; 
result := result / ri; 

homog := result; 
end ; 

end ; 

{THIS PROCEDURE CALCULATES THE TEXTURE CORRELATION OF A GIVEN SGLD MATRIX} 

procedure texture_correlation (var matphp: matptr; d : integer; nx: longint ; ny: longint; 
angle : integer; var correlation : real); 

var 
i, j : integer ; 
ri , sdx, sdy, result: real ; 
x, y, subtotal, total : real; 

{THIS FUNCTION CALCULATES THE MEAN X OF A GIVEN SGLD MATRIX) 

function meanx (p: matptr; ri: real): real ; 
var 

i, j : integer; 
tempmean, sumx: real; 

begin 
with info" .roirect do 
begin 

tempmean := 0.0; 
for i := gmin to gmax do 
begin 

sumx == 0.0; 
for j := gmin to gmax do 

sumx := sumx + (matphp"[i, j) / ri); 
tempmean := tempmean + ((i - !row) • sumx); 

end; 
meanx := tempmean 

end ; 
end; 

{THIS FUNCTION CALCULATES THE MEANY OF A GIVEN SGLD MATRIX} 
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function meany (p: matptr; ri: real): real; 
var 

i, j: integer; 
tempmean, sumy : real; 

begin 
with info".roirect do 
begin 

tempmean := 0 .0; 
for j := gmin to gmax do 
begin 

sumy := 0.0; 
for i := gmin to gmax do 

sumy := sumy + (m atphp"[i, j] / ri); 
tempmean := tempmean + (sumy • (j - !col)); 

end ; 
meany := tempmean; 

end; 
end ; 

{THIS FUNCTION CALCULATES THE STD DEV X OF A GIVEN SGLD MATRIX} 

function stdevx (p: matptr; ri: real; meanx: real): real; 
var 

i, j : integer ; 
sum, variance : real ; 

begin 
with info". roirect do 
begin 

variance := 0.0 ; 
for i := gmin to gmax do 
begin 

sum:= 0.0; 
for j := gmin to gmax do 

sum := sum + (matphp" [i, j] / ri); 
variance := variance + ((sqr(i - lrow - meanx)) • sum); 

end ; 
stdevx sqrt(variance) : 

end; 
end ; 

{THIS FUNCTION CALCULATES THE STD DEVY OF A GIVEN SGLD MATRIX} 

function stdevy (p : matptr ; ri: real; meany : real) : real ; 
var 

i, j, width: integer; 
sum, variance : real ; 

begin 
with info".roirect do 
begin 

variance := 0.0; 
for j := gmin to gmax do 
begin 

sum:= 0.0; 
for i := gmin to gmax do 

sum := sum + (matphp"[i, j] / ri); 
variance := variance + ((sqr(j - lcol - meany)) • sum); 

end; 
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stdevy 
end; 

end ; 

begin 

sqrt(variance); 

with info A.roirect do 
begin 
case angle of 

O: 
ri := 2 • ny • (nx - d) ; 

45 , 135: 
ri := 2 • (ny - d) • (nx - d); 

90: 
ri := 2 • nx • (ny - d); 

end ; 
x := meanx(matphp, ri) ; 
y := meany(matphp, ri) ; 
sdx := stdevx(matphp, ri , x) ; 
sdy := stdevy(matphp, ri, y): 
total := 0; 

if (sd x = 0.0) or (sdy = 00) then 
result := 1.0 

else 
begin 
tor i := gmin to gmax do 
begin 
subtotal := 0.0; 

for j := gmin to gmax do 
begin 

subtotal := subtotal + ((i - lrow - x) • (j - lcol - y) • (matphpA[i, j) / ri )); 
end ; 

total := total + subtotal : 
end ; 

result := total / (sdx • sdy); 
end ; 
correlation 

end ; 
end ; 

result; 

{THIS IS THE MAIN PROCEDURE OF THE PROGRAM) 

procedure process_ image (var matphp : matptr; D: integer) ; 
var 

zeroline : matphlinetype ; 
line: linetype; 
nx, ny: longint; 
i, j, m, n, vloc, hloc, k, angle: integer; 
energy, entropy, homog, inertia, correlation : real ; 
tot1, tot2, tot3 , tot4, tots : real; 
sumf1 sq, sumf2sq, sumf3sq, sumf4sq, sumf5sq: real; 
maxen, maxent, maxinert, maxhomog . maxcor: real; 
minen, minent. mininert, minhomog, mincor: real ; 
rangef1, rangef2, rangef3, rangef4, rangef5 : real ; 
sd1, sd2, sd3, sd4, sd5 : real ; 

begin 
with . info".roirect do 
begin 
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gmax := O; 
gmin := 255 ; 

for vloc := top to bottom - 1 do 
begin 

getline (left, vloc, width, line ); 
for hloc := 0 to width - 1 do 

begin 
if line[hloc] >= gmax then 

gmax := line[hloc] ; 
if line[hloc] <= gmin then 

gmin := line[hloc]; 
end ; 

end ; 
gwidth := gmax - gmin + 1 · 

with Te xtu re do 
begin 

{Finds the maximum gray level in the image} 

{F inds the minimum gray level in the image} 

TF := 1; {Tells program which table to use - TF1 is the SGLOM table} 
end ; 

angle := O; 

k := 1 ; 

tot1 := 0.0: 
tot2 := 0.0 ; 
tot3 := 0.0; 
tot4 := 0.0: 
tots := o.o; 

minen := 1 .O ; 
minent := 1.0e+ 1 O; 
min inert := 1.0e+ 1 O; 

minhomog := 1.0 ; 
mincor := 1.0; 

maxen := 0.0: 
maxent := 0.0; 
maxinert := 0.0; 
maxhomog := 0.0 ; 
maxcor := 0.0: 

sumf1 sq := 0.0; 
sumf2sq := 0.0; 
sumf3sq := 0.0; 
sumf4sq := 0.0; 
sumfSsq := 0.0; 

nx := urow - lrow + 1; 
ny := ucol - lcol + 1 ; 

for j :=Oto 255 do 
zeroline[j] := O; 

repeat 
for i := 0 to 255 do 

matphp"[i] := zeroline ; 
case angle of 

O: 

{Clears the MATPHP matrix before use} 
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sgldm_zero(matphp, D); 
45: 

sgldm_fortyfive(matphp, D); 
90: 

sgldm_ninety(matphp, D) : 
135: 

sgldm_onethreefive(matphp, D); 
end; 

texture_energy(matphp, D, nx, ny, angle, energy); 
texture_entropy(matphp, D, nx, ny, angle, entropy); 
texture_inertia(matphp, D, nx, ny, angle, inertia): 

texture_homog(matphp, D, nx, ny, angle, homog ); 
texture_correlation(matphp, D, nx, ny, angle, correlation); 

with Texture do 
begin {Puts the results into the texture record for display to the results window} 

TextureData[k , 1] := energy; 
TextureData[k, 2] := entropy; 
TextureData[k, 3] := inert ia; 

TextureData[k , 4] := homog: 
TextureData[k , 5] := correlation; 

end ; 

tot1 := tot1 + energy ; 
tot2 := tot2 + entropy; 
tot3 := tot3 + inertia; 
tot4 := tot4 + homog; 

{Sums th e results for use in determining the averages} 

tot5 := tot5 + correlation: 

sumf1 sq := sumf1 sq + energy • energy; {Likewise sum of squares for the standard} 
(deviation} 

sumf2sq := su mf2sq + entropy • entropy ; 
sumf3sq := sumf3sq + inertia • inertia; 

sumf4sq := sumf4sq + homog • homog ; 
sumfSsq := sumf5sq + correlation • correlation; 

if (energy> maxen) then 
maxen := energy; 

{Finds the maximum and minimum feature values} 

if (energy < minen) then 
minen := energy; 

if (entropy > maxent) then 
maxent := entropy; 

if (entropy < minent) then 
minent := entropy ; 

if (inertia > max inert) then 
maxinert := inertia; 

if (inertia < min inert) then 
mininert := inertia; 

if (homog > maxhomog) then 
maxhomog := homog ; 

if (homog < minhomog) then 
minhomog := homog; 

if (correlation > maxcor) then 
maxcor := correlation : 

if (correlation < mincor) then 
mincor := correlation ; 
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k == k + 1; 
angle := angle + 45 ; 

until (k > 4) or (angle > 135); 

rangef1 := maxen - minen: {F inds the ranges} 
rangef2 := maxent - minent: 
rangef3 := ma xinert - mininert; 

rangef4 := maxhomog - minhomog; 
rang ef5 := maxcor - mincor: 

sd1 sqrt(sumf1 sq I 4 (tot1 • tot1) I 16); 
sd2 sqrt(sumf2sq I 4 (tot2 • tot2) I 16); 
sd3 sqrt(sumf3sq I 4 (tot3 tot3) I 16): 
sd4 sqrt(sumf4sq / 4 (tot4 tot4) / 16); 
sd5 sqrt(sumf5sq I 4 (tot5 • tot5) I 16); 

tot1 := tot1 I 4; {Finds the means} 
tot2 := tot2 / 4 ; 
tot3 := tot3 / 4; 
tot4 = tot4 I 4: 
tot5 := tot5 / 4; 

with Texture do 

{F inds the standard deviations} 

begin {Puts results into the texture record for display to the results window} 
Te xtureOata[5, 1] - 1011: 
Te xtureOata[5, 2] .- tot2 : 
Te xtureOata[5, 3] tot3: 
TextureOata[5, 4] tot4 : 
Te xtureOata[5, 5] tot5: 

TextureOata[6, 1] := maxen ; 
TextureOata[6 , 2] := maxent; 
TextureOata[6 , 3] := maxinert ; 
TextureOata[6, 4] := maxhomog; 
TextureOata[6 , 5] := maxcor; 

TextureData[?, 1] := minen: 
TextureOata[7 , 2] := minent; 
TextureData [?, 3) := mininert; 
TextureOata[7, 4) := minhomog ; 
TextureOata[7, 5) := mincor: 

TextureOata[8 , 1] := rangef1 ; 
TextureOata[8, 2] := rangef2: 
TextureOata[8, 3] := rangef3; 
TextureOata[8, 4) := rangef4 ; 
TextureOata(8, 5] := rangef5; 

TextureData[9. 1] := sd 1: 
TextureOata(9, 2] := sd2 ; 
TextureOata[9, 3] := sd3: 
TextureOata[9, 4] := sd4; 
TextureOata[9, 5] := sd5; 

Spacing := d; 

Measure; 
ShowResults; 
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end ; 
end ; 

end ; 

{THIS IS THE MAIN PART OF THE PROGRAM} 

begin 
with info".roirect do 
begin 

width := right - left; 
height := bottom - top; 
lrow := top; 
urow := bott om - 1 ; 
lcol := left; 
ucol := right - 1; 

if was accepted th en 
exi t(DoSGLDM); 

it D > width th en 
b eg in 

putmessage(concat('lntersample Spacing D ·, long2str(D), · is greater than width ·, 
long2str(wid th), '. Please try again')): 

exit(DoSGLDM); 
end ; 
matphp := matptr(NewPtr(sizeof(matph) )); 

if matphp = nil th en 
goto 100; 

process_image(matphp, D); 
DisposP tr(Ptr(matphp)): 

matphp := nil: 
end ; 

1 00: 
en d ; 

procedure DoGLDM; {GLOM) 
label 

100; 

{THIS PROCEDURE COMPUTES THE GRAY LEVEL DENSITY FUNCTIONS FROM THE IMAGE} 

proce dure compute_den_ fn (va r denfn_O: denfn_Optr; var denfn_ 45 : denfn_ 45ptr; var 
denfn_90: denfn_90ptr; var denfn_1 35: denfn_ 135ptr; e: integer); 

type 
mlinetype = a rray (0 .. 500) of long int; 
mtype = array (0 .. 500) of mlinetype; 
mptr = "mtype; 

var 
zeroline: mlinetype; 
m : mptr; 
line: linetype; 
i, j , x: integer; 
nfl , nf2, nf3, nf4 : longint ; 

begin 
with info".roi rect do 
begin 

m := mptr(NewPtr(sizeof(mtype))) ; 
if m = nil then 
goto 100; 
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for x:=O to 255do 
zeroline[x] := O; 

for i := top to bottom - 1 do 
for j := left to right - 1 · e d o 

m"[i , j] := abs(mygetpixel(j, i) - mygetpixel(j + e, i)); 
nf1 := (urow - I row + 1) • (ucol - lcol - e + 1 ) ; 

for i := top to bottom - 1 do 
tor j := left to right - 1 · e d o 

denfn_O"[m"[i, j] ] := denfn_O"[m"[i, j]] + 1 ; 

for i :=top+ e to bottom · 1 do 
for j := left to right - 1 · e do 

m"[i , jl := abs (mygetpixel(j, i) · mygetpixel(j + e , i · e)); 
nf2 := (urow . I row - e + 1) • (ucol · lcol - e + 1 ); 

for i := top+ e to bottom · 1 do 
for j := left to right · 1 · e do 

denfn_ 45"[m"[i, j]] := denfn_ 45"[m"[i, j]] + 1 ; 

for i := top to bottom· 1 · e do 
for j := left to right· 1 do 

m"[i , j] := abs(mygetpixel(j, i) . mygetpixel(J. 1 + e)); 
nf3 := (urow - I row - e + 1) • (ucol . lcol + 1 ): 

for i := top to bottom. 1 • e do 
for j := left to right · 1 do 

denfn_90"[m"[i, ill := denfn_90"[m"[i. j)] + 1; 

for i := top to bottom. 1 • e do 
for j := left to right - 1 • e do 

m"[i, il := abs(mygetpixel(j. i) . mygetpixel(j + e, i + e)) ; 
nf4 := (urow - lrow - e + 1) • (ucol - lcol - e + 1); 

for i := top to bottom - 1 - e do 
for j := left to right - 1 - e d o 

denfn_135"[m"[i, j]] := denfn_135" [m" (i , j]] + 1; 

tor i := 0 to 255 d o 
begin 

denfn_O"(i] := denfn_O"[i] I nil; 
denfn_ 45"(i) :::: denfn_ 45" [i] I nf2; 
denfn_90"[i] := denfn_90"(i] I nf3; 
denfn_ 135" (i) = denfn_ 135"[i] / nf4; 

end ; 

DisposPtr(Ptr(m)); 
m := nil; 

end; 
end; 

{THIS PROCEDURE CALCULATES THE FEATURE SET FROM THE DENSITY FUNCTIONS} 

procedure GLDM_features (e: integer); 
var 

asm, ent, mean, idm, con : array(1 .. 4] of real ; 
i, j: longint; 
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110, sumcon, sumasm, sument, sumean, sumidm: real; 
avecon, aveasm, aveent, avemean, aveidm: real; 

begin 
with info".roirect do 
begin 

11 O := ln(10); 
if (e < width) or (e < height) then 
begin 
tor i := 0 to 255 d o 
begin 

denfn_O" (i) := 0.0 ; 
denfn_ 45"[i) := 0.0 ; 
denfn_go"[i] := 0.0; 
denfn_ 135"(i) := 0. O: 

end; 
tor i := 1 to 4 d o 
begin 

asm[i) := 0.0; 
mean[i) := 0.0; 
ent[i] := 0.0 ; 
idm[i) := 0.0: 
con[i) := 0.0: 

end ; 

with Texture do 
begin 
TF := 2; {Tells program which table to use - TF2 is the GLDM table} 

end ; 

sumcon := 0.0: 
sumasm := 0.0; 
sumean := 0.0; 
sument := 0.0; 
sumidm := 0.0; 

compute_den_fn(denfn_O, denfn_ 45, denfn_90, denfn_ 135, e) ; 

for i := O to 255 do 
begin 

con[1) := con(1] + ((i • i) • denfn_O"[i)); 
con[2] := con[2) + ((i • i) • denfn_ 45"[i]); 
con[3) := con[3) + ((i • i) • denfn_90"(i)); 
con(4] := con(4] + ((i • i) • denfn_ 135"(i)); 

asm(1] := asm(1] + (denfn_O"(i) • denfn_O"(i]); 
asm[2] := asm[2] + (denfn_ 45"(i] • denfn_ 45"(i]); 
asm[3] := asm[3] + (denfn_90"(i] • denfn_90"(i)); 
asm(4] := asm[4) + (denfn_135"[i] • denfn_135"[i]); 

If (denfn_O"(i) <> 0) then 
ent[1) := ent[1) - (denfn_O"(i] • (ln(denfn_O"(i]) / 11 O)); 

If (denfn_ 45"[i] <> 0) then 
ent[2] := ent[2] - (denfn_ 45"(i) • (ln(denfn_ 45"[i]) / 11 O)) ; 

it (denfn_90"[i] <> 0) then 
ent[3] := ent[3] - (denfn_90"(i] • (ln(denfn_90"(i]) / 11 O)); 

If (denfn_135"(i] <> 0) then 
ent[4] := ent[4] - (denfn_ 135"(i] • (ln(denfn_ 135"(i]) / 11 O)}; 
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mean[1] := mean[1] + (i • denfn_0"[i]); 
mean[2] := mean[2] + (i • denfn_ 45"[i]); 
mean[3] := mean[3] + (i • denfn_90"[i]); 
mean[4] := mean[4] + (i • denfn_135"[i]) ; 

idm[1] 
idm[2] 
idm[3] 
idm[4] 

idm[1] + (den fn_0"[i] I (i • i + 1 )); 
idm[2] + (denfn_ 45"[i] / (i • i + 1 )); 

= idm[3] + (denfn_90"[i] / (i • i + 1 )); 
idm[4] + (denfn_ 135"[i] / (i • i + 1 )); 

end ; 

for i:=1to 4 do 
begin 
sumcon := sumcon + con[i]; 
sument := sument + ent[i]: 
sumidm := sumidm + idm[i]; 
sumasm := sumasm + asm[i]; 
sumean := sumean + mean[i]: 

end ; 

{Sums the results} 

avecon := sumcon / 4.0; 
aveent := sument I 4.0: 
aveidm := sumidm I 4 0: 
aveasm := sumasm / 4.0: 
avemean := sumean I 4.0: 

{Finds the mean results} 

with Texture do 
begin {Puts the results into the texture record for display} 
tor i := 1 to 4 do 
begin 

TextureData[i, 1] := con[i]; 
TextureData[i, 2] := asm[i]; 
TextureData[i , 3] := ent[i]: 
TextureData[i, 4] := mean[i]; 
TextureData[i, 5] := idm[i]; 

end; 
TextureOata[5 , 1] := avecon: 
TextureData[S, 2] := aveasm; 
TextureData[5, 3] := aveent; 
TextureData[S, 4] := avemean : 
TextureData[S, 5] := aveidm; 

Spacing := e: 

end ; 
Measure; 
ShowResults ; 

end ; 
end; 

end; 

{THIS IS THE MAIN PART OF THE PROGRAM} 

begin 
with info".roirect do 
begin 
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width := right - left; 
height := bottom - top: 
lrow := top; 
urow := bottom - 1; 
lcol := left; 
ucol := right - 1; 

if wasaccepted then 
exit(DoGLDM); 

if E > width then 
begin 

putmessage(concat('lntersample Spacing D ·• long2str(E), · is greater than width ', 
long2str (wid th). ·. Please try again')); 

exit(DoGLDM): 
end ; 
denfn_O := denfn_Optr(NewPtr(sizeof(denfn_Otype))); 
denfn_ 45 := denfn_ 45ptr(NewPtr(s izeof(denfn_ 45type))); 
denfn_90 := denfn_90ptr(NewPtr(sizeof(denfn_90type))); 
denfn_ 135 := denfn_ 135ptr(NewPtr(sizeo f(denf n_ 135type)) ): 

if denfn O = nil then 
goto 100; 

if denfn_ 45 nil th en 
goto 100; 

if denfn_90 = nil th en 
goto 100; 

if denfn_135 = nil then 
goto 100; 

gldm_features(e) ; 

OisposPtr(Ptr(denfn_O)); 
OisposP tr(Ptr(denfn_ 45)): 
DisposP tr(Ptr(denfn_90)); 
D isposPtr(Ptr(denfn_ 135) ); 

denfn_O := nil ; 
denfn_ 45 := nil ; 
denfn_90 := nil; 
denfn_135 := nil: 

end ; 
1 00 : 
end ; 

procedure OoGLRLM; {GLRLM) 
label 

100; 
con st 

maxlen = 400; 
type 

mtype = array(1 .. 20, 1 .. maxlen] of longint; 
mptr = " mtype; 
imagelinetype = array[O .. maxlen] of longint; 
imagetype = array(O .. maxlen] of imagelinetype; 
imageptr = " imagetype; 

var 
m: mptr; 
image: imageptr; 
i , j, k, p, q, maxsize. f1 : integer; 
sre, Ire, rpc, glnu, rlnu, rlnu1: real; 
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sre2, lre2, rpc2, glnu2, rlnu2, rlnu3: real; 
sre90, lre90, rpc90, glnu90, rlnu90, rlnu900 : real; 
sre135, lre135, rpc135, glnu135, rlnu135, rlnu1350: real; 
avesre, avelre, averpc, aveglnu, averlnu: real; 

wasaccepted : boolean ; 

beg in 
with info".roirect do 
begin 

f1 := 0; 
width := right - left; 
height := bottom - top; 
lrow := top; 
urow := bottom - 1; 
lcol := left ; 
ucol := right - 1; 
m := mptr(NewPtr(sizeof(mtype))); 

ifm=nilthen 
goto 100; 
image := imageptr(NewPtr(sizeof(imagetype))); 

if image = nil then 
goto 100; 

if (height >= width) then 
maxsize := height 

else 
maxsize := width ; 

if maxsize > 256 then 
putmessage('lmage too big for GLRLM - Choose smaller region of interest'); 

with Te xture do 
begin 
TF := 3 ; 

end; 

for i := lrow to urow do 
begin 
for j := lcol to ucol do 

{Tells program which table to use - TF3 is the GLRLM table} 

image"[i, j] := trunc(mygetpixel(j, i) / 12.8) + 1; 
end; 

for i := lrow to urow do 
begin 

image"(i, lcol] := O; 
image"[i, ucol] := O; 

end; 
for j := lcol to ucol do 
begin 

image"(lrow, j) := 0; 
image"[urow, j) := O; 

end; 

tor p := 1 to 20 d o 
begin 
for q := 1 to maxsize do 

m"[p, q] := 0; 
end; 
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for i == lrow + 1 to urow - 2 do 
begin 
tor j := lcol + 1 to ucol - 2 d o 
beg in 

k := O; 
if image"[i , j - 1] <> image"[i, j] then 
begin 
repeat 
k := k + 1; 
until image"[i , j] <> image"[i, j + k]; 

m 11 (image 11 [i , j), k] := m"[image"[i, j]. k] + 1; 
end; 

end ; 
end ; 

sre := O; 
Ire := O; 
rpc := O; 
rlnu := O: 
rlnu1 := O; 
glnu := O; 
tor p := 1 to 20 d o 
begin 
for q := 1 to maxsize do 
begin 

sre := sre + m"[p, q] / (longint(q) • q); 
Ire := Ire + m" [p, q] • longint(q) • q; 

rpc := rpc + m" [p , q]; 
end; 
glnu := glnu + rpc • rpc ; 

end; 
for q := 1 to maxsize do 
begin 
for p := 1 to 20 do 
begin 

rlnu := rlnu + m"[p, q]: 
end; 
rlnu1 := rlnu1 + rlnu • rlnu : 

end ; 
sre := sre / rpc ; 
Ire == Ire / rpc; 
glnu := glnu / rpc; 
rlnu := rlnu1 / rpc; 
rpc := rpc / ((urow - !row+ 1) • (ucol - lcol + 1)); 

with Texture do 
begin {Puts the results into the texture record for display} 

TextureData[1, 1] := sre; 
TextureData[1, 2] := Ire; 
Texture0ata[1, 3] := glnu; 
TextureData[1, 4] := rlnu; 
TextureData[1, 5] := rpc ; 

end; 

f1 := 1; 

tor i := lrow to urow do 

B19 



begin 
for j := lcol to ucol do 

image"[ i, j] := trunc(mygetpixel(j , i) / 12.8 ) + 1 ;{Converts image to 20 grayscales} 
end ; 

for i := lrow to urow do 
begin 

image"[i, lco l) := O; 
image"[i, ucol ] := O; 

end ; 
for j := lcol to ucol do 
begin 

image"[lrow, j] := O; 

image"[urow, j] O; 

end ; 

far p := 1 to 20 do 
beg in 
for q := 1 to maxsize do 

m"[p, q] := O; 
end ; 

for i := lrow + 1 to urow · 2 do 
beg in 
for j := lcol + 1 to ucol · 2 do 
beg i n 

k := O; 
if image"[i · 1, + 1] <> image" [i, j] then 
begin 
repeat 
k := k + 1; 
until image"[i, j] <> image"[i + k, j + k]; 

m"[image"[i, j], k] := m"[image"[i, j]. k] + 1; 
end ; 

end ; 
end ; 

sre2 := O; 

lre2 := O; 

rpc2 := O; 

rlnu2 := O; 
rlnu3 := O; 
glnu2 := O; 
for p := 1 to 20 do 
begin 
for q := 1 to maxsize do 
begin 

sre2 := sre2 + m"[p, q] / (longint(q) • q) ; 
lre2 := lre2 + m"[p, q] • longint(q) • q ; 

rpc2 := rpc2 + m"[p, q] ; 
end ; 
glnu2 := glnu2 + rpc2 • rpc2 ; 

end ; 
for q := 1 to maxs ize do 
begin 
for p := 1 to 20 do 
begin 

rlnu2 := rlnu2 + m"[p, q] ; 
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end; 
rlnu3 .- rlnu3 + rlnu2 • rlnu2; 

end; 
sre2 := sre2 / rpc2; 
lre2 := lre2 I rpc2 ; 
glnu2 := glnu2 / rpc2; 
rlnu2 := rlnu3 I rpc2 ; 
rpc2 := rpc2 / ((urow · lrow + 1) • (ucol · lcol + 1 )) ; 

with Texture do 

begin {Puts the results into the texture record for display} 
Texture0ata[2 , 1) sre2; 
Te xtu re0ata[2 . 2) := lre2; 
Texture 0ata[2 , 3) := glnu2 ; 
Te xture 0ata[2, 4) := rlnu2; 
Texture0ata[2, 5) := rpc2; 

end; 

f1 := 2; 

for i := lrow to urow do 
beg in 
for j := lcol to ucol do 

image"[i , j) := trunc( mygetpixel(j. i) / 12.8) + 1; 
end ; 

for i := lrow to urow do 
begin 

image"[i, lcol) := O; 
image"[i. ucol] := O; 

end ; 
for j := lcol to ucol do 
begin 

image"[lrow, j) := O; 
image"(urow, j] := O; 

end ; 

for p := 1 to 20 do 
begin 
for q := 1 to maxsize do 

m"[p, q] := O; 
end; 

for i := lrow + 1 to urow · 2 do 
begin 

for j := lcol + 1 to ucol · 2 do 
begin 

k := O; 
if image"[i · 1, j] <> image"(i, j] then 
begin 
repeat 
k := k + 1; 
until image"[i, j) <> image"[i + k, j); 

m"[image"[i, j], k] := m"[image"(i, j]. k] + 1; 
end; 

end; 
end; 
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sre90 := 0; 
lre90 := O; 
rpc90 := O; 
rlnu90 := O; 
rlnu900 := O; 
g lnu90 := O; 
tor p := 1 to 20 d o 
begin 
for q := 1 to maxsize do 
begin 

sre90 := sre90 + m"[p, q] / (longint(q) • q); 
lre90 := lre90 + m"[p, q] • longint(q) • q; 
rpc90 := rpc90 + m"[p, q]; 

end ; 
glnu90 := glnu90 + rpc90 • rpc90: 

end ; 
for q := 1 to maxsize do 
begin 
for p := 1 t o 20 do 
begin 

rlnu90 := rlnu90 + m"[p, q]: 
end ; 

rlnu900 := rlnu900 + rlnu90 rlnu90: 
end ; 
sre90 := sre90 I rpc90: 
lre90 := lre90 / rpc90; 
glnu90 := glnu90 / rpc90; 
rlnu90 := rlnu900 / rpc90: 
rpc90 := rpc90 / ((urow - lrow + 1) • (ucol - lcol + 1 )); 

with Texture do 
begin {Puts the results into the texture record for d isplay} 

TextureOata[3, 1] .- sre90: 
TextureOata[3, 2] := lre90; 
TextureOata(3, 3] := glnu90; 
TextureOata[3, 4] = rlnu90; 
TextureOata(3. 5] := rpc90: 

end ; 

f1 '.= 3; 

for i := lrow to urow do 
begin 
tor j := lcol to ucol do 

image" [i , j] = trunc(mygetpixel (j, i) / 12.8) + 1; 
end ; 

for i := lrow to urow do 
begin 

image" [i , lcol] := O; 
image"[i, ucol] := O; 

end; 
for j := lcol to ucol do 
begin 

image"[lrow, j] := 0 ; 
image"(urow, j] := 0 ; 

end ; 
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tor p := 1 to 20 d o 
begin 
for q := 1 to maxsize do 
m" [p , q] := O; 

end ; 

for i := lrow + 1 to urow - 2 do 
beg in 
tor j := lcol + 1 to ucol - 2 d o 
beg in 

k := O; 
if image"[i - 1, j - 1) <> image"[i, j] then 
begin 
repeat 
k := k + 1; 
until image"[i , j] <> image"[i - k, j - k]; 

m" [image"[i, j], k] := m"[image" [i, j], k] + 1; 
end ; 

end ; 
end ; 

sre135 := O; 

lre 135 := O; 
rpc135 := O; 
rlnu1 35 := O; 
rlnu1 350 := O; 

glnu135 := O; 

tor p := 1 to 20 d o 
begin 
for q := 1 to maxsize do 
begin 

sre 135 := sre1 35 + m"(p, q] / (longi nt(q) • q) ; 
lre135 := lre1 35 + m"[p , q] • longint(q) • q; 
rpc135 := rpc135 + m" [p, q] ; 

end; 
glnu135 := g lnu 135 + rpc135 • rpc135; 

end ; 
for q := 1 to maxsize do 
begin 
for p := 1 to 20 do 
begin 

rlnu135 := rlnu135 + m" [p, q] ; 
end; 

rlnu1350 := rlnu1350 + rlnu135 • rlnu135 ; 
end ; 
sre135 := sre135 I rpc135 ; 
lre135 := lre135 / rpc135 ; 
glnu135 := glnu135 I rpc135; 
rlnu135 := rlnu1350 I rpc135 ; 
rpc135 := rpc135 / ((urow - lrow + 1) • (ucol - lcol + 1)); 

with Texture do 
begin {Puts the results into the texture record for display} 

TextureData(4, 1] = sre135; 
TextureData[4, 2] := lre135; 
TextureData[4, 3] := glnu135; 
Texture0ata(4, 4] := rlnu135 ; 
Texture0ata(4, SJ := rpc135; 
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end; 

avesre (sre + sre2 + sre90 + sre135) / 4; {Finds the mean of the results} 
avelre := (Ire + lre2 + lre90 + lre135) / 4; 

aveglnu := (glnu + glnu2 + glnu90 + glnu135) / 4; 
averlnu := (rlnu + rlnu2 + rlnu90 + rlnu135) / 4; 
averpc := (rpc + rpc2 + rpc90 + rpc135) / 4; 

with Texture do 
begin {Puts the results into the texture record for display} 

TextureOata[5 , 1] .- avesre ; 
TextureData[S, 2] := avelre ; 
TextureData(S, 3] := aveglnu; 
TextureData(S, 4] averlnu; 
TextureData[S, 5] := averpc; 

end; 

Measure ; 
ShowResults ; 

DisposPtr(Ptr(m)); 
m := nil; 
DisposPtr(Ptr(image)) ; 

image := ni l; 
end ; 

1 00: 
end ; 

procedure OoNGLDM; {NGLDM} 
label 

100; 
CO n St 

Ir = O; 
ur = 255; 
le= O; 
UC = 255; 

type 
qtype = array[lr .. ur, lc .. uc] of longint ; 
qptr = "qtype ; 

var 
q: qptr; 
i, j, sn, s, k, dd : longint ; 
tot1, tot2, tot3, tot4, tots, subtotal : real; 
n1, n2, n3, n4, n5, nf, 11 O: real ; 
wasaccepted1, wasaccepted2: boolean; 

begin 
with info".roirect do 
begin 

110 := ln(10); 
width := right - left; 
height := bottom - top; 
lrow := top; 
urow := bottom - 1 · 
lcol := left; 
ucol := right - 1 ; 

if wasaccepted then 
exit(DoNGLDM); 
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if G1 > width then 
begin 

putmessage(concat('ln tersample Spacing D ', long2str(G 1 ), ' is greate r than width ', 
long2str(width). ·. Please try again')) ; 

exit(DoNGLDM): 
end ; 
q := qptr(NewPtr( sizeof(qtype))); 

i fq = nil then 
goto 100; 

with Texture do 
begin 
TF := 4; {Tells program which table to use - TF4 is the NGLDM table} 

e nd ; 

if ((g1 < (height div 2)) and (g1 < (width d iv 2))) then 
if ((g1 > 0) and (g1 < 10)) th en 
begin 
tor i := Ir t o ur d o 
for j := le to uc do 
q"[i , j] := O; 

for i := lrow + g1 to urow - g1 do 
for j := lcol + g1 to ucol - g1 do 
begin 
s := O; 
dd:= g1 ; 
repeat 
if abs(mygetpixel(j, i) - mygetpixel(j + dd, i)) <= a 1 th en 
s := s + 1; 

if abs(mygetpixel(j, i) - mygetpixel(j + dd, i - dd)) <= a 1 then 
s := s + 1 ; 

if abs(mygetpixel(j, i) - mygetpixel(j. i - dd)) <= a1 then 
s := s + 1; 
if abs(mygetpixel(j, i) - mygetpixel(j - dd, i - dd)) <= a1 then 
s := s + 1; 
if abs(mygetpixel(j , i) - mygetpixel(j - dd, i)) <= a1 then 
s := s + 1; 

if abs(mygetpixel(j. i) - mygetpixel(j - dd, i + dd)) <= a1 then 
s := s + 1; 
if abs(mygetpixel(j, i) - mygetpixel(j. i + dd)) <= a1 then 
s := s + 1; 
if abs(mygetpixel(j. i) - mygetpixel(j + dd, i + dd)) <= a 1 then 
s := s + 1; 
dd := dd · 1; 
until (dd < 1 ); 

q " [mygetpixel(j, i), s] := q " [mygetpixel(j, i), s] + 1; 
end ; 

tot1 := 0.0; 
tot2 := 0.0; 
tot3 := 0.0; 
tot4 := 0.0 ; 
tots := o.o; 
subtotal := 0.0; 
nf := 0.0; 

for k := Ir to ur do 
for sn := le to uc do 
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begin 
ifsn<>Othen 

totl := toll + q"[k, sn] / (sn • sn); 
tot2 := tot2 + (sn • sn) • q"[k, sn]; 
tot4 := tot4 + (q"[k, sn] • q"[k, sn]); 

nf := nf + q" [k, sn] ; 
end; 

for sn le to uc do 
begin 
fork := Ir tour do 
begin 
if (q"[k, sn] <> 0) then 

tots := tots - ((q"[k, sn] / nf) • ln(q"[k , sn] / nf) / 110) ; 
subtotal := subtotal + q"[k, sn]; 

end; 
tot3 := tot3 + (subtotal • subtotal); 

subtotal := 0.0; 
end ; 

nl := totl I nf; 
n2 := tot2 I nf; 
n3 := tot3 I nf; 
n4 := tot4 I nf; 
n5 := tots I nf; 

with Texture do 
begin {Puts the results into the texture record for display} 

TextureData[1, 1] = nl : 
TextureData[l, 2] := n2 ; 
TextureData[1, 3] := n3; 
TextureData[l, 4] n4 ; 
TextureData[l , 5] := n5; 

Spacing := gl ; 
qw := al; 

end; 
Measure ; 
ShowResults : 

DisposPtr(Ptr(q)) ; 
q := nil; 

end; 
end; 

1 00: 
end; 

procedure RankFilter; 

con st 
PixelsPerUpdate = 5000; 

var 

{ Filter rank 1 .. 9, rank5=median filter } 

i, j, x, y, pix, Mark, NewMark, LinesPerUpdate, LineCount: integer; 
StartTicks, PixelsRemoved: longint; 
k: char; 
pt: point; 
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MaskRect, frame, tree!: rect; 
line: linetype ; 
position, leftof: integer; 
hist: a rray(0 .. 255] of integer; 
buffer: array(0 .. 1] of LineType; { buffer filtered rows so they can be} 

{ put back into original image to save memory } 
bp: byte; { buffer pointer } 
first, AutoSelectAII , UseMask: boolean; { flag to stop row being modified until it isn't} 

{ needed for processing subsequent rows } 

begin 
if NotinBounds then 

exit(RankFilter) ; 
AutoSelectAII := not lnfo ". RoiShowing; 
if AutoS electAII then 
with info" do 
begin 

SelectAll(false); 
SetPort(wptr); 

Pen Normal ; 
PenPat(pat[Patlndex] ): 
F rameRect(wrect) ; 

end ; 
if TooWide then 

exit(RankFilter); 
ShowWatch ; 
if info" .RoiType <> RectRoi then 
UseMask := SetupMask 

else 
UseMask := false ; 

frame := info".RoiRect ; 
StartTicks := TickCount; 
with frame, info" do 
begin 

changes := true ; 
RoiShowing := false ; 
if left> 0 then 

left := left - 1 ; 
if right < PicRect.rig ht then 

right := right + 1; 
width := right - left; 
height := bottom - top; 
LinesPerUpdate := PixelsPerUpdate div width; 
LinesPerUpdate := LinesPerUpdate div 3; 
Mark := RoiRect.top; 
LineCount := O; 
if wasaccepted then 

exit( RankFilter); 
If (Rank< 1) or (Rank > 9) then 
begin 

putmessage(concat('Rank has to be between 1 and 9 inclusive')) ; 
exit(RankFilter); 

end; 
getline(left, top, width, line) ; 

for i := left to right - 1 do 
line[i] := O; {Makes top row white} 
putline(left, top, width, line); 
getline(left, bottom - 1, width, line); 

B27 



for i := left to right - 1 do 
line[i] := O; 

putline(left , bottom - 1, width , line); 
getcolumn(left , top, he igh t. line); 

for i := top to bottom - 1 do 
line[i] := O; 

putcolumn(left, top, heigh t. line); 
getcolumn(right - 1, top, height, line) ; 

for i := top to bottom - 1 do 
line[i] := O; 

putcolumn(right - 1, top, height, line) ; 
for x := 0 to 1 do 
for y := 0 to 1024 do 
begin 

buffer[x , y] := O; 
end ; 

bp := O; { in itialise buffer pointer } 
First := true; 

for i :=top+ 1 to bott om - 1 do 
begin { all rows} 

getline(left . i, width. line) : { get original } 
buffer[bp] := line ; 

for x := 0 to 255 do { empty histogram 
hist[x] := O; 

Pos ition := 128; { guess middle } 
Leftof := O; 

for y := left to left+ 1 do { first 2 cols} 
for x := i - 1 to i + 1 do 
begin { 3 rows centred on i} 

pix := mygetpixel(y, x); 
hist[pix] := hist[pix] + 1 ; 

if pix < position then 
leftof := leftof + 1; 

end ; { for x } 
for j :=left+ 1 to right - 2 do 
begin { rest of columns } 
for x := i - 1 to i + 1 do 
begin { 3 rows, load new column } 

pi x := mygetpixe l(j + 1, x); 
hist[pix] := hist[pix] + 1: 

if pix < position then 
leftof := leftof + 1 ; 

end ; 
repeat { search up } 

leftof := leftof + hist[position]; 
position := position + 1; 

until leftof >= Rank ; 
repeat { search down } 

position := position - 1 : 
leftof := leftof - hist[position]; 

u nt i I leftof < Rank; 
buffer[bp, j] := unsignedbyte(Position) ; 

for x := i - 1 to i + 1 do 
begin { 3 rows , unload old column } 

pix := mygetpixel(j - 1, x); 
hist[pix] := hist[pix] - 1; 

If pix < Position then 
leftof := leftof - 1 ; 
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end ; 
end; { for j} 
bp := bp + 1; 
bp := bp mod 2; {2 element 'ring' } 
ifi-1<>0 then 
begin 
if UseMask then 

PutlineUsingMask(left, i - 1, width, buffer[bp]) 
else 

Putline( left, i - 1, width , buffer[bp]); 
end ; 
LineCount := LineCount + 1; 

if LineCount = Lines PerUpdate then 
begin 

pt.h := RoiRect.left; 
pt.v := i + 1; 
NewMark := pt.v ; 

with RoiRect do 
SetRect(Mask Rect, left , mark, right, NewMark); 

UpdateScreen(MaskRect): 
LineCount := O; 
Mark := NewMark; 

if magnification> 1.0 then 
Mark := Mark - 1; 

if Comm and Period then 
begin 
UpdatePicWindow; 
beep; 
PixelsRemoved := O; 

if AutoSelectAII th en 
KillRoi ; 
exit(RankFilter); 

end ; 
end; 

end ; {for i} 
trect := frame ; 
lnsetRect(trect , 1, 1 ); 
ShowTime(StartTicks, trect, ") : 

end ; {with} 
if LineCount > 0 then 
begin 
with frame do 

SetRect(MaskRect, left, mark, right , bottom) ; 
UpdateScreen( MaskRect) ; 

end ; 
If AutoSelectAII then 

KillRoi; 
end; 

{---------- -- ------- -------------

p raced u re RangeFilter; 

co nst 
PixelsPerUpdate = 5000 ; 

var 

Range Filter 

{ Filter ranks 1 .. 9} 

--------------------------------} 

i, j, x, y, pix, Mark, NewMark, LinesPerUpdate, LineCount: integer; 
StartTicks, PixelsRemoved : longint; 
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k: char; 
pt: point; 
MaskRect , frame, trect : reel: 
line: linetype ; 
position_h, position_!, leftof_h, leftof I: integer; 
hist: array(0 .. 255] of integer; 
buffer: array(0 .. 1] of LineType; { buffer filtered rows so they can be } 

{ put back into original image to save memory } 
bp: byte ; { buffer pointer } 
first, AutoSelectAII , UseMask: boole an; { fl ag to stop row being modified until it isn't} 

{ needed for processing subsequent rows } 

begin 
if NotinBounds then 

exit(RangeFilter); 
AutoSelectAII := not lnfo".RoiShowing; 
if AutoSelectAII then 
with info" do 
begin 

SelectAl l(false); 
SetPort(wptr ); 

Pen Normal; 
PenPat(pat(Patlndex]) : 
Frame Rect(wrect); 

end; 
if TooWide then 

exit(RangeFilter): 
ShowWatch ; 
if in fo" .RoiType <> RectRoi then 
UseMask := SetupMask 

else 
UseMask := false ; 

frame := info".RoiRect; 
Star!Ticks := TickCount ; 
with frame, info" do 
begin 
changes := true; 
RoiShowing := false ; 
it left > 0 t he n 

left := left - 1 ; 
it right < PicRect.right then 

right := right + 1; 
width := right - left; 
height := bottom - top; 
LinesPerUpdate := PixelsPerUpdate div width; 
LinesPerUpdate := LinesPerUpdate div 3; 
Mark := RoiRect.top; 
LineCount := O; 
it wasaccepted then 

exit(RangeFilter); 
if (Rank_h < 1) or (Rank_h > 9) or (Rank_l < 1) or (Rank_l > 9) then 
begin 

putmessage(concat('Ranks have to be between 1 and 9 inclusive')); 
exit(RangeFilter); 
getline(left, top, width, line) ; 

for i := left to right - 1 do 
line[i] := O; {Makes top row white} 
putline(left, top, width, line); 
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getline(left, bottom - 1, width, line); 
for i := left to right - 1 do 

line[i) := O; 
putline (left, bottom - 1, width, line); 
getcolumn(left, top, height, line); 

for i := top to bottom - 1 do 
line [i) := O; 
putcolumn(left, top, height, line); 
getcolumn(right - 1, top , height, line); 

for i := top to bottom - 1 do 
line[i) := O; 
putcolumn(right - 1, top, height, line); 

end ; 
for X := 0 t O 1 d 0 

for y := 0 to 1024 do 
begin 

buffer[x, y) := O; 

end ; 
bp := O; { initialise buffer pointer } 
First := true; 

for i :=top+ 1 to bottom - 1 do 
beg in { all rows } 

getline(left, i, width , line): { get original 
buffer[bp) := line: 

for x := 0 to 255 do { empty histogram 
hist[x] := O; 

Position_h := 128; 

Position_! := 128; { guess middle } 
Leftof_h := O; 
Leftof_l := O; 

for y := left to left + 1 do { first 2 cols} 
for x := i - 1 to i + 1 do 
begin { 3 rows centred on i} 

pix := mygetpixel(y, x); 
hist[pix] := hist[pix) + 1; 

if p ix < posi tion_h then 
leftof_h := leftof_h + 1: 

if pix < pos it ion_! then 
leftof_l := leftof_l + 1; 

end ; { for x } 
for j := left + 1 to right - 2 do 
begin { rest of columns } 
for x := i - 1 to i + 1 do 
begin { 3 rows, load new column } 

pix := mygetpixel(j + 1, x); 
hist[pix) := hist[pix) + 1; 

if pix < position_h then 
leftof_h := leftof_h + 1; 

if pix < position_! then 
leftof_l .- leftof_l + 1 ; 

end ; 
repeat { search up } 

leftof_h := leftof_h + hist[position_h) ; 
position_h := position_h + 1; 

until leftof_h >= Rank_h; 
repeat { search down } 

position_h := position_h - 1; 
leftof_h .- leftof_h - hist[position_h) ; 
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until leftof_h < Rank_h; 
repeat { search up } 

leftof_l := leftof_l + hist[posi tion_l]; 
position_! := position_! + 1; 

until leftof_l >= Rank_l ; 
repeat { search down} 

position_ ! := position_! - 1: 

leftof_l := leftof_ l - hist[position_l]; 
u n ti I le ftof_l < Rank_l: 

buffer[bp, j] := unsignedbyte(Position_ h - Position_ !) ; 
for X := i - 1 t O i + 1 d O 

begin { 3 rows, unload old column } 
pix := mygetpixel(j - 1, x}; 
hist[pix] := hist[pix] - 1; 

if pix < Position_h then 
leftof_h := leftof_h - 1: 

if pix < Posi tion_! then 
leftof_l := leftof_ l - 1: 

end ; 
end ; { for j} 

bp := bp + 1: 
bp := bp mod 2; (2 element 'ring· } 

if i- 1 <>0 then 
b e gin 
if UseMask then 

PutlineUsingMask(left, i - 1, width, buffer[bp]) 
else 

Putline(left, i - 1, width , buffer[bp]): 
end ; 

LineCount := LineCount + 1: 
if LineCount = LinesPerUpdate then 
begin 

pt.h := RoiRect. left; 
pt.v := i + 1; 
NewMark := pt.v ; 

with RoiRect do 
SetRect(MaskRect, left, mark, right, NewMark}; 

UpdateScreen(MaskRect); 
LineCount := O; 
Mark := NewMark; 

if magnification > 1.0 then 
Mark := Mark - 1: 

if CommandPeriod then 
begin 
UpdatePicWindow; 
beep; 
PixelsRemoved := O; 

if AutoSelectAII then 
KillRoi; 
exit(RangeFilter) ; 

end; 
end; 

end; { for i } 
trect := frame; 
lnsetRect(trect, 1, 1) ; 
ShowTime(StartTicks, trect, ") ; 

end; {with} 
if LineCount > O then 
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begin 
with frame do 

SetRect(MaskRect, left, mark, right, bottom); 
Update Screen( MaskRect); 

end ; 
if AutoSelectAII then 

KillRoi; 
end ; 

procedure Connectivity ;{Th is procedure counts the number of voids per successive MAX 
fi I te rs} 
v a r 

black_no: integer; 

proc e dure Blob; 
var 
i, j : INTEGER; 
equiv: INTEGER; 
b_next: INTEGER; 

max_left: longint; 
new_val: INTEGER; 

} 

{This procedure counts the number of voids in an image} 

{ Variables used for scanning through the image.} 
{ Used for relabelling equivalent blobs with different labels.} 
{ Next available black label.} 
{ Maximum label out of PL and PAL (PML)} 
{ New label value for a blob when relabelling a line. 

labels: ar r ay [O .. 1 000) of integer; 
temp: array[0 .. 1, 0 .. 1000) of integer; 

{------ ------------------ - - ---------------------- -----------------------------} 

fun c ti on MIN (x1 : longint: x2 : longint): longint;{Finds the minimum of x1 and x2} 
var 

minimum: longint ; 
begin 

minimum := 10000000; 
if (x1 < minimum) t hen 

minimum := x1: 
if (x2 < minimum) then 

minimum := x2; 
MIN := minimum; 

end; 

function MAX (x1: longint: x2: longint): longint;{Finds the maximum of x1 and x2} 
var 

maximum: longint: 
begin 

maximum := 0; 
if (x1 > maximum) then 

maximum := x1: 
if (x2 > maximum) then 

maximum := x2; 
MAX := maximum; 

end ; 

procedure add_label 
var level, 

count: INTEGER; 
c: INTEGER); 

begin 
w Ith info", info" .picrect 
begin 

do 

{ Labels temp with a new label} 
{ The next available label} 
{ The number of blobs thus far} 
{ Position in temp being labelled} 
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temp[1, c] := level; 
labels(level] := level; 

count := count + 1; 
level := level + 1 ; 

end ; 
end ; 

procedure add labelzero 
var level, 

count: INTEGER; 
c: INTEGER); 

begin 
with info". info" .picrect do 
begin 

temp(0, c] := level; 
labels[level] := level; 

count := count + 1; 
level := level + 1: 

end ; 
end; 

{ Fix label in the merge table} 
{ New blob so increment count} 
{ Next available level) 

{ Labels temp with a new label) 
{ The next available label} 
{ The number of blobs thus far} 
{ Position in temp being labelled) 

{ Fix label in the merge table) 
{ New blob so increment count} 
{ Next available level) 

{-------------------------- -- --- -- -- --- -------------------------- - ------------} 
procedure merge ( 

var count : INTEGER: 
c: INTEGER; 

11, 12: INTEGER) ; 
var 

min_v: longint ; 
begin 

{ Merge two blobs together} 
{ The number of blobs thus far) 
{ Position in temp being labelled} 
{ The two labels being merged} 

{ The labels bei ng merged - sorted} 

count := count - 1; { Since two blobs are being merged together, decrement the} 
{blob count.} 

min_v := MIN(labels(l1 ]. labels(l2]); { Sort the two labels to find the minimum and} 
{maximum} 

temp[1, c] := labels(min_v]:{Label image with the minimum label.} 
labels(l1] labels[min_v]; { Fix other labels to that of the minimum.} 
labels[l2] .- labels(min_v]; 

end; 

begin 
with info", info".picrect do 
begin 

black_no := 0; Initialise counters - no blobs have been found yet} 
b_next := 1; Black labels go from 1 to 999. The first available label is 1.) 

if mygetpixel(left, top) >= 128 then { Add a label for the first pixel} 
add_labelzero(b_next, black_no, left) 

else 
temp(top, left] := 1000: 

for j :=left+ 1 to right - 1 do 
begin { Label first row} 
If mygetpixel(j, top) >= 128 then 
If mygetpixel(j - 1, top) >= 128 then 

temp(0, j] := temp[O, j - 1] { P = BLK, PL = BLK - use same label} 
else 

add_labelzero(b_next, black_no, j) { P = BLK, PL= WHT - new black label} 
else 

temp[0, j] := 1000; 
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end; 

tor i := top + 1 to bottom - 1 d o { Count blobs on a row by row basis} 
begin 
it mygetpixel(left, i) >= 128 then { First pixel in new row} 
it mygetpixel(left, i - 1) >= 128 then 

temp[1, left] := temp[0 , left] { P = BLK, PA = BLK - use same label} 
else 

add_label(b_next, black_no, left) { P = BLK, PA = WHT - new black label} 
else 

temp[1, left] := 1 000: 

tor j := left + 1 to right - 1 do 
begin 

max_left := MAX(temp[1, j - 1], temp[0, j - 1]);{ Maxim um label of PL and PAL (PML).} 
{This is the label} 

it mygetp ixe l(j, i) >= 128 then 
it mygetpixel(j. i - 1) >= 128 then 
it mygetpixel(j - 1, i) >= 128 then 
if label s[temp[1, j - 1 ]l = labels[temp[0, ill then 

temp[1, j] := labels[temp[1, j - 1]] { P = BLK, Pl=PA = BLK - use same label.} 
else 

merge(black_no, j, temp[1, j - 1 ], temp[0, j]) { P = BLK, PL<>PA - merge PL and PA.} 
else 

temp[1, j] := labels[temp[O, ill 
else if temp[1, j - 1] < 1000 then 

temp[1, j] := labels[temp[ 1, j - 1 ]] 
else 

{ P = BLK, PL = WHT, PA=BLK - use PA label.} 

{ P = BLK, PL = BLK, PA = WHT - use PL label 

add_label(b_next, black_no, j) { P = BLK, PL = WHT, PA = WHT - new black label.} 
else 

temp[1, j] := 1000; 
end ; {forj} 

Second scan across line to relabel pixels. Blobs thus far (on th is line) are completely 
relabelled to reflect merges. A label is marked as relabelled in the label table by pointing to a 
level of the opposite type - ie black blobs are indicated by white in the table. This is used as a 
translation table for relabelling pixels. The label table is then corrected for th e next row 
after relabelling is complete.} 

b_next := 1; { Reset first available label counters. } 
tor j := left to right - 1 do 
begin 
it temp[1, j] <> 1000 then 
it ((temp(1, j] < 1000) and (labels[temp[1, j]] < 0)) th en 

temp[1, j] := -labels(temp(1, j]] 
else 
begin 

equiv := temp[1, j] ; 
repeat 
equiv := labels[equiv]; 

{ Search through mergers in the table until a base label,} 
{ or one which has been reallocated is found} 

until (equiv = labels[equiv]) or (labels(equiv] < 0) ; 
{ Base label - minimum label after a merge Label has been reallocated .} 

it equiv = labels[equiv] then 
begin 
new_val := b_next; 
b_next := b_next + 1: 

end 
else 

{ Black base label was found - allocate a new black label} 

new_val := -labels[equiv] ; { Part of blob already relabelled , so use same label} 
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equiv := temp(1, j] ; 
temp[1, j] := new_val ; 

repeat 

{ Hang onto old label for correcting the label table} 
{ Relabel image with the label obtained} 

max_left := labels(equiv]; 
labels[equiv] := -n ew_val; 
equiv := max_left; 

until ((equiv< 1000) and 
end; 

{ Set equivalent labels in the table to label obtained.} 

(labels[equiv] < O) ); 

end ; {for j) 

for j := 1 to b_next do 
labelsLi] := j; 

{ Fi x the labels in the label table for the next line} 

for j := left to right - 1 do 
temp[O, j] := temp[1, j]; 

end ; {for i} 
User2 11 [mCount] := black_no: 

end ; 
end ; 

begin 
Rank := 9;{Sets rank of rank filter to 9 - MAX filter} 
repeat 
Measure ; 
Blob; {Counts the number of voids} 
RankFilter; {Adds a layer of pixels to vo ids using a MAX fil te r} 

until black_no = 1: 
ShowResults ; 

end ; 

procedure WeightedArea ; 
type 

areatype = array [0 .. 8000] of real; 
areaptr = 11 areatype ; 

var 
Area , diffarea: areaptr: 
i, j: intege r; 

begin 
Area := AreaPtr(NewPtr(sizeof(areatype))); 
diffArea := AreaPtr(NewPtr(sizeof(areatype))); 

blOD := true ; 
Rank := 1; {Sets rank of rank fil ter to 1 - MIN filter} 
j := 1; 
Area"(O) := 1.0 ; 
repeat 
Measure; 

{Measures the area of the voids in the image} 
Area"UJ := (mean"[j] I 255) • mArea"U] ; {Finds the area} 

If U <> 1) and (Area 11 LJ - 1) > 0.0) then 
begin 

di ff Area "Li - 1) := Area 11 [j - 1) - Area"[j] ; 
{Finds the area difference due to removed layer of pixels} 

User2"[j - 1) := (j - 1) • diffArea"[j - 1 ); 
User2"Li) := 0.0; {Puts results into User2 array for display to results window} 

end; 
If Area 11U] > 0.0 then 

RankFilter; 
j := j + 1; 

{Applies MIN filter} 
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until Area"U - 1] = 0.0: {Conti nue until all the voids have disappeared} 
ShowResults; 
DisposPtr(Ptr(Area ) ); 
DisposPtr(Ptr(diff Area)): 

end ; 

procedure DoNeighbour; 
{This procedure finds the distances to the four nearest ne ighbours for each void} 
{and calculates the change in effective area due to the ignored voids on the edges} 
type 

mintype = array(0 .. 8000] of real; 
minptr = "mintype: 

var 
minmin: minptr ; 
i, j : integer; 
dx, dy, sqrdx, sqrdy, total, min, dist: real; 
disttop, di stbottom, di stleft, distright, maxmin: real; 
newtop, newbottom , newleft. newright: extended; 

procedure FindMin; {Finds the distance to the nearest boundary for each void} 
begin 

minmin"[i] := 1 e1 O: 
if disttop < minmin " (i) then 

minmin"[i] := dis ttop ; 
if distbottom < minmin"[i] then 

minmin"[i] := distbottom: 
if distle ft < minmin"[i] then 

minmin"[i] := distleft ; 
if distr ight < minmin"[i] then 

minmin"[i] distright : 
end ; 

procedure FindMax1 ;{Finds the maximum distance from the nearest boundary} 
{at which no first nearest neighbour existed} 
{This is used in finding the area change due to the outer voids being ignored} 

var 
i: integer ; 
begin 

maxmin := O; 
for i := 1 to mCount do 
begin 
if (User2"(i) = 0) and (minmin"(i] > maxmin) then 

maxmin := minmin"[i]; 
end; 

end ; 

procedure FindMax2;{Finds the maximum distance from the nearest boundary} 
{at which no second nearest neighbour existed} 
{This is used in finding the area change due to the outer voids being ignored} 

var 
i: integer; 

begin 
maxmin := O; 
for i := 1 to mCount do 
begin 
If (User3 11(i] = 0) and (minmin 11[i) > maxmin) then 

maxmin := minmin 11(i); 
end; 
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end ; 

procedure FindMax3;{Finds the maximum distance from the nearest boundary} 
{at which no third nearest neighbour existed} 
{Th is is used in find ing the area change due to the outer voids being ignored} 

var 
i : integer; 
begin 

maxmin := 0; 
for i := 1 to mCount do 
begin 
if (User4"(i] = 0) and (minmin"(i] > maxmin) then 

maxmin := minmin"(i]; 
end ; 

end ; 

procedure FindMax4;{Finds the maximum distance from the nearest boundary} 
{at which no fou rth nearest neighbour existed) 
{This is used in finding the area change due to the outer voids being ignored) 

var 
i: integer ; 
begin 

maxmin := 0; 
for i := 1 to mCount do 
begin 
if (User5"(i] = 0) and (m inmin"(i] > maxmin) then 

maxmin := minmin"(i]: 
end ; 

end ; 

begin 
min min minptr( NewPtr( sizeof( min type))); 

with info", info" .picrect do 
begin 

Analyze Particles; 
{Finds the X-Y positions of all the voids in the image} 

for i := 1 to mCount do 
begin 

min := 1e1 0; 
if SpatiallyCalibrated then 
begin {finds the distances all the boundaries if a scale has been set} 

newtop := top I xSpatialScale; 
newbottom := bottom I xSpatialScale ; 
newleft := left I ySpatialScale; 
newright := right I ySpatialScale; 
disttop := abs(ycenter"(i] - newtop); 
distbottom := abs(newbottom - ycenter"[i]); 
distleft := abs(xcenter"(i] - newleft) ; 
distright := abs(newright - xcenter"[i]) ; 

end; 
if not SpatiallyCalibrated then 
begin {finds the distances all the boundaries if a scale has not been set} 

disttop := abs(ycenter"[i] - top); 
distbottom := abs(bottom - ycenter"[i]); 
distleft := abs(xcenter"(i] - left); 
distright .- abs(right - xcenter"[i]); 

end; 
FindMin; 
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for j := 1 to mCount do 
begin {Finding the first nearest neighbour distances} 
ifi <> jthen 
begin 

dx := xcenter"U] xcenter"[i]; 
dy := ycenter"U] ycenter"[i]: 

sqrdx := dx • dx ; 
sqrdy := dy • dy ; 
total := sq rdx + sqrdy; 
dist := sqrt(total); 

if dist <= min then 
min := dist 

end ; {for i<>j} 
end : {for j} 

if min > minmin"[i] then 
min:= O; 
User2"[i] := min; 

end ; {for i} 
FindMax1; 
for i := 1 to mCount do 
begin 
if minmin"[i] < maxmin then 

User2"[i] := O; 

{Sets first nearest neighbour distance to O if closer to boundary than nearest void} 
{Also puts the first nearest neighbour distances into the User2 array for d isplay} 

end : 
if SpatiallyCalibrated then 

{Calculates area change due to outer voids being ignored for first neighbour level} 
{and stores in mArea array for display} 

mArea"[l] := (abs(newtop - newbottom) - (2 • maxmin)) • (abs(newright - newleft) - (2 
• maxmin)); 

if not SpatiallyCalibrated then 
mArea"[1] := (abs(top - bottom) - (2 • maxmin)) • (abs(right - left) - (2 • maxmin)); 

for i := 1 to mCount do 
begin 

min:= 1e10; 
if SpatiallyCalibrated then 
begin 

newtop := top I xSpatialScale; 
newbottom := bottom / xSpatialScale; 
newleft := left I ySpatialScale; 
newright := right I ySpatialScale; 
disttop := abs(ycenter"[i] - newtop) ; 
distbottom := abs(newbottom - ycenter"[i]); 
distleft := abs(xcenter"[i] - newleft); 
distright := abs(newright - xcenter"[i]) ; 

end ; 
If not SpatiallyCalibrated then 
begin 

disttop := abs(ycenter"[i] - top); 
distbottom := abs(bottom - ycenter"[i]) ; 
distleft := abs(xcenter"[i] - left); 
distright := abs(right - xcenter"[i]); 

end; 
for j := 1 to mCount do 
beg In {Finding the second nearest neighbour distances} 
If i <> j then 
begin 
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dx := xcenter"Li] xcenter"[i]; 
dy := ycenter"Li] • ycenter"(i]; 

sqrdx := dx • dx : 
sqrdy := dy • dy; 
total := sqrdx + sqrdy: 
dist := sqrt(total); 

if (d ist > User2"[i]) and (dist <= min) then 
min := dist 

end ; {fo r i<>j} 
end ; {for j} 

if min > minmin"[i) then 
min := O: 

if User2"[i) = 0 th en 
{if first nearest neighbour level does not exist then the second cannot} 

min:= O; 
User3"[i) := min: 

end ; {for i) 
FindMax2; 
for i := 1 to mCount do 
b egin 
if minmin"[i] < max min t hen 

User3"[i) := O: 
{Sets second nearest neighbour distance to O if closer to boundary than the second nearest} 
{void. Also puts the second nearest neighbour distances into the User3 array for display} 

end : 
if SpatiallyCal1brated then 

{Calculates area change due to outer voids being ignored for second neighbour level) 
{and stores in mArea array for display) 

mArea" [2] := (abs(newtop · newbottom) · (2 • maxmin)) • (abs(newright · newleft) · (2 
• maxmin)) ; 

if n o t SpatiallyCalibrated then 
mArea"[2) := (abs(top · bottom) - (2 • maxmin)) • (abs(right - left) · (2 • maxmin)); 

for i := 1 to mCount do 
beg in 

min := 1e10; 
if SpatiallyCalibrated th en 
begin 

newtop := top I xSpatialScale; 
newbottom := bottom / xSpatialScale; 
newleft := left I ySpatialScale: 
newright := right I ySpatialScale; 
disttop := abs(ycenter"(i) - newtop); 
distbottom := abs(newbottom • ycenter"[i)) ; 
distleft := abs(xcenter" [i) • newleft); 
distright := abs(newright - xcenter"[i)) : 

end ; 
If not SpatiallyCalibrated then 
begin 

disttop := abs(ycenter" [i] • top) ; 
distbottom := abs(bottom - ycenter" [i)) ; 
distleft := abs(xcenter"(i] - left); 
d istright := abs(right · xcenter" [i]) ; 

end; 
for j := 1 to mCount do 
beg In {Finding the third nearest neighbour distances} 
If i <> j then 
begin 

dx := xcenter"Li] - xcenter"[i) ; 
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dy := ycenter"Li] - ycenter"[i]; 
sqrdx := dx • dx : 
sqrdy := dy • dy: 
total := sqrdx + sqrdy: 
dist := sqrt(total); 

if (dist > User3"[i]) and (dist <= min) th en 
min := dist 
end ; (for i<>j} 
end ; {for j} 

if min > minmin"[i] then 
min:= O; 

if User3"[i] = O then 
{if second nearest neighbour level does not exist then the third cannot} 

min:= O; 
User4"[i] := min; 

end ; {for i} 
FindMax3; 
for i := 1 to mCount d o 
begin 
if minmin"[i] < maxmin then 

User4"[i] := O: 
{Sets third nearest neighbour distance to O if closer to boundary than the third nearest void) 
{Also puts the third nearest neighbour distances into the User4 array for display} 

end ; 
if SpatiallyCalibrated t hen 

{Calculates area change due to outer voids being ignored for third neighbour level) 
{and stores in mArea array for display} 

mArea"[3] := (abs(newtop - newbottom) - (2 • maxmin)) • (abs(newright - newleft) - (2 
maxmin)); 

it not SpatiallyCalibrated then 
mArea"[3] := (abs(top - bottom) - (2 • maxmin)) • (abs(right - left) - (2 • maxmin)); 

for i := 1 to mCount do 
begin 

min:= 1e10; 
it SpatiallyCalibrated then 
begin 

newtop := top I xSpatialScale; 
newbottom := bottom I xSpatialScale; 
newleft := left / ySpatialScale; 
newright := right / ySpatialScale; 
disttop := abs(ycenter"[i] - newtop) ; 
distbottom := abs(newbottom - ycenter"[i]); 
distleft := abs(xcenter"(i] - newleft}; 
distright := abs(newright - xcenter"(i]); 

end ; 
if not SpatiallyCalibrated then 
begin 

disttop := abs(ycenter"(i] - top}; 
distbottom := abs(bottom - ycenter" [i]); 
distleft := abs(xcenter"(i] - left); 
distright := abs(right - xcenter"[i]): 

end ; 
for j := 1 to mCount do 
beg In {Finding the fourth nearest neighbour d istances} 
If i <> j then 
begin 

dx := xcenter"Li] - xcenter"[i]; 
dy := ycenter"Li] - ycenter"(i]; 
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sqrd x := dx • dx; 
sqrdy := dy • dy; 
total := sqrd x + sqrdy; 
di st := sqrt(total); 

if (dist > User4A[i]) and (dist<= min ) then 
min := d ist 

end ; {for i<>j} 
end ; {fo r j} 

if min > minminA[i] the n 
min := 0 ; 
if Use r4A[i] = 0 then 

{if third nearest neighbour level does not exist then the fourth cannot} 
min := 0; 
UserSA [i] := min; 

end ; {for i} 
FindMax4; 
for i := 1 to mCount do 
begin 
if minminA[i] < maxmin then 

UserSA[i] := 0: 
{Sets fourth nearest neighbour distance to 0 if closer to boundary than the fou rth nearest 
void. Also puts the fourth nearest neighbour distances into the Users array for d isplay) 

end ; 
if SpatiallyCalibrated t hen 

{Calculates area change due to outer voids being ignored for fourth neig hbour level} 
{and stores in mArea array for display} 

mArea"[4] := (abs(newtop - newbottom) - (2 • maxmin)) • (abs( newr igh t - newleft) - (2 
• maxmin)); 

if not SpatiallyCalibrated th e n 
mArea"[4] := (abs(top - bottom) - (2 • maxmin)) • (abs( righ t - left ) - (2 • maxmin) ); 

ShowResults ; 
end ; 
Disp os Pt r( Ptr( min min)); 

end ; 

procedure Do Area Factor; 
{This procedure finds the area factor for each void in the image} 

var 
i, j : integer; 
dx , dy , sqrdx, sqrdy, total, sum, dist, area/ac tor: real; 

begin 
AnalyzePart icles ; {F inds the area and the X-Y position for every vo id in the image} 

for i := 1 to mCount do 
begin 

sum := 0.0 ; 
for j := 1 to mCount do 
begin 

dx := xcenter"Li] - xcente r" [i] ; 
dy := ycenter"[j] - ycente r"[i] ; 

sqrdx := dx • dx; 
sqrdy := dy • dy ; 
total := sqrdx + sqrdy ; 
dist := sqrt(total) ; 

if dist <> 0 then 
begin 

area factor := (mArea "Ol • 100) I total ; 
sum := sum + areafactor; 

end ; 
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end ; 
User2"[i] .- sum; 

end ; 
{Puts the area factor for each void into the User2 array for display} 

ShowResults : 
end ; 

procedure DoDistanceFactor: 
{This procedure finds the di stance factor for each void in the image) 
v a r 

I, J: integer ; 
dx, dy, sqrdx, sqrdy, tota l, sum, dist, distfactor: real ; 

begin 
AnalyzePart icl es: {F inds the X-Y posi tion for every void in the image} 

for i := 1 to mCount do 
begin 

sum := 0.0; 
for j := 1 to mCount do 
beg in 

dx := xce nter"[j] xcente r" [i]: 
dy := ycen te r"[j] ycente r" [i]; 

sqrd x := dx • dx; 
sqrdy := dy • dy: 
total := sqrd x + sq rdy: 
dist := sqrt(total ): 

if dist<> 0 then 
begin 

distfactor := 100000 / total : 
sum := sum + distfactor: 

end ; 
end ; 
User2"[i] sum; {Puts the distance factor for each void into the User2 array for 

display} 
end ; 
ShowResults; 

end ; 

procedure Circularity;{Finds the circular ity of every void in the image} 
var 

i, j : integer ; 
circ : real ; 

begin 
AnalyzePart icles; {Finds the major and minor elliptical axes for every void in the image} 

for i := 1 to mCount do 
begin 

circ := MinorAx is"[i] MajorAxis"[i]; 
User2"[i) := circ ; 

end; 
ShowResults ; 

end ; 
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APPENDIX C 

Table of Critica l Va lues in the Kolgom orov-Smirnov Two-Sa mple Test 

(Large Samples: two- tailed test) 

Level of S ignificance (%) Critica l Value 

90.0 1.22~ '1i +f½ 
111'½ 

95.0 1.36~", + n, 
'¾'½ 

97.5 1. 48~ n, + n, 
ll1f½ 

99.0 l.63~ n1 + '½ 
'1i'½ 

99.5 1. 73 I n l + '½ 
\1 f1i112 

99.9 l.95f1 +n, 
'1i '½ 

where n 1 and n2 are the two sample sizes be ing tested. 

(Source: Adapted from S. Siegel. Nonparametric Scacisrics for rhe Behavioural Sciences. 

McGraw-Hill , New York, 1956. 279p.) 
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APPENDIX D - Texture Equations 

SGLDM Features: 

(1) Energy 

E = II[f(i, j,d,a)]2 

i=O j=O 

(2) Entropy 

Ng-!Ng-1 

ENT= - I, L,[f(i, j,d,a). log10 (f( i,j,d,a))] 
i=O j=O 

(3) Inertia 

l\'g-11':g-l 

INERTIA= I, L,[(i- j) 2
. f(i,j,d,a)] 

i=O j=O 

(4) Homogeneity 

Ng-!Ng-1 

HOMOG.= I I,[f(i , j,d,a) / (1 + (i- j)2 )] 
i=O j=O 

(5) Correlation 

Ng-! Ng-1 

COR.= I I,[(i - µx)(j- µy) .f(i,j,d,a) / (ax. oy)] 
i=O j=O 

Where 

Ng-I Ng-1 

µx = I, i 2,[f(i,j,d,a)] 
i=O j=O 
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Ng-! Ng-! 

ax= L (i-µx)2 L,[f(i ,j,d,a)] 
i=O j=O 

Ng-! 1'g-l 

ay = I (j-µyf :I,[f(i,j ,ct ,a)J 
j=O i=O 

GLDM Features: 

(1) Contrast 

Ng-! 

CON= L,[i 2P'(i)] 
i=O 

(2) Angular Second Moment 

l\"g-1 

ASM = L, [P' (i)] 2 

i=O 

(3) Entropy 

l\"g-1 

ENT= - L,[P'(i). log10 (P' (i))] 
i=O 

(4) Mean 

MEAN =(-1 J I'.[i.P'(i)] 
Ng i=O 

(5) Inverse Different Moment 

Ng-I 

IDM = L,.[P' (i) / (i2 + l)] 
i=O 

G LRLM Features: 

(1) Long Run Emphasis 

~I Nr ~I Nr 

LRE = LL,.[/P(i,j)]/ LLl(i,j) 
i• O j•l iRO j=l 

D2 



(2) Short Run Emphasis 

Ng-I Nr J\"g -1 J\"r 

SRE = I2)P(i,j)/ j2J;I,I,P(i,j) 
i=O j=l i=O j= I 

(3) Gray Level Nonuniformity 

(4) Run Length Nonuniformity 

(5) Run Percentage 

RPC = II,P(i,j)/P" 
i=O j=I 

Where P" is the Number of pixels in the image. 

NGLDM Features: 

(1) Small Number Emphasis 

K S 

SNE= I2)Q(k,s)/s2 ]/R 
k=O s=O 

Where R is the normalising factor 

(2) Large Number Emphasis 

K S 

LNE = I,I,[s2Q(k,s)]/ R 
~-0 a=O 

Where R is the normalising factor 
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(3) Number Nonuniformity 

S [ K ]

2 

NNU = ~ ~Q(k,s) / R 

Where R is the normalising factor 

(4) Second Moment 

K S 

SM= L,L,[Q(k ,s)]2 
/ R 

k=O s=O 

Where R is the normalising factor 

(5) Entropy 

K S 

ENT= - L,L,[Q(k,s).log10 (Q(k,s))]/ R 
k=O s=O 

Where R is the normalising factor 
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APPENDIX E - Comalco Contracts 

Anode Macroscopy Image Analysis Research Proposal 

Comalco Aluminium Limited have developed an optical macroscopy technique for 

assessing the pitching level and degree of compac tion in baked anodes. The technique 

currently requires a subjective interpretation of the anode macrostructure. 

Massey University are experienced in image process ing. It should be poss ible to use this 

experience to deve lop an automatic qualitative analysis of anodes based on the 

macroscopy technique. It is, therefore proposed that Massey University develop image 

analysis algorithms which will indicate the level of porosity in anode samples or 

photographs of samples. 

The final software should be able to detect: 

• the number of pores in a sample and their position (eg in a coke grain , in the 

binder-fines matrix) 

the shapes of pores and cracks in the sample 

• the total porosity of the surface 

• an unusual disoibution of pores in the anode and their position 

This information should lead to the development of an expert system (either at Massey 

University or at CRC) which will indicate the presence of: 

. incorrect pitching levels 

• compaction faults 

• baking cracks 

. coke porosity 

. macropores 

. delamination cracks 

CAL will supply to the university, macrographs of common anode faults and of 

laboratory and plant samples produced under a range of conditions. A list of features to 

be detected will accompany each macrograph. 

At the completion of the project (June 1993), Massey University will supply to CAL, 

subject to the standard terms and conditions, a disk containing the working software 
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package written in C including a documented copy of source code, a user's manual and 

any training required to run the software. Knowledge of C should not be necessary to run 

the package. The University should also provide a progress report six months after the 

project commencement and a copy of the student thesis at the completion of the project. 

Restatement of th e Aim/Methodology of the Image Analys is Project 

As requested, this letter res tates what CRC expect from the Massey macroscopy project 

and contains CRC's suggestions on how to achieve it. 

Deliverables 

CRC expects from Massey the deliverables outlined in the original Research Proposal, 

which were: 

1. A software package contain ing prototype image analysis / sample preparation 

techniques to descri be anode macrostructure (4 to 5 are suggested) 

2. Verification that these techniques can detect pore distribution , association of 

pores, the location of pores (i nside coke grains or in the binder matrix), cracks in 

the matrix and the aspec t ratios of these cracks. 

Comalco (possibly in conj unction with Massey) would then evaluate these techniques at 

its smelters, to detect the anode structures listed in the proposal. 

It is suggested that you first aim to assess the anode binder-fines matrix so that pitching 

level and compaction efficiency can be determined. 

Other aims such as: 

• measuri ng coke/butt particle porosity so that the effect of raw coke qual ity 

(especially porosity) on pitching level can be monitored, and 

• detecting delamination cracking and large bake cracks 

are more difficult to meet as large samples are required to obtain a representative 

measurement. I would consider attempting these goals after techniques to assess the 

binder-fines matrix have been developed and tested. 

Methodology 

A four step process is suggested: 

1. Develop image analysis routines and sample preparation techniques which 

recognise anode macrostructures which Comalco uses to assess anode quality 

(pitching level etc). These structures have been thoroughly discussed in a CRC 

E2 



report (TM/86/89) written by Barry Sadler. Don Bailey summed up well the type 

of structures which should be detected in his NZAS trip report (17-18 November 

1992). 

Match the samples which you already have and which CRC/NZAS have ranked 

with the macrosrructures in Barry's report. Then work from these samples. 

CRC would not, however, put a great deal of effort into rrying to equate all these 

samples and all the surface of the samples with the ranking because: 

• the ranki ng is subjective , not a robust analytical procedure 

even three or four photographs will not cover a 50mm diameter sample (20 

or 30 would be required at a lOx magnification) 

T he progress reports indicate promising algori thms and sample preparation 

techniques which CRC recommend evaluating before developing more. 

2. Evaluate the potential of the image analysis techniques by assessing the 20mm x 

50mm diameter NZAS compaction samples which you have. These samples have 

been formed under a range of process parameters which effected the physical 

properties of the material. Strong correlations with: 

forming compaction force (h igh, low, normal) 

forming time (25s, 45s, 75s) and 

forming temperature (may effect pitch penetration, pore distribution) 

would indicate promising techniques. In this way subjective judgements would be 

avoided (I have included a history of these samples in case you do not have all the 

information) . 

As you have pointed out the aim of the project is not to develop analysis 

techniques which solely replicate other physical tes ts. It is expected, however, 

that the binder-fines matrix structure would be sensitive to some of these process 

parameters and the usefulness of the project would be proven immediately if the 

techniques: 

• were more sensitive to process parameters than the physical tests 

• detected differences in the binder-fines matrix (pore size distribution, 

cracking etc) which could be attributed to the forming conditions 

• explain differences which the physical tests could not (eg variations 

between mixer rounds) 

E3 



The techniques could then be used to evaluate anodes of different pitching levels 

etc, for which the tests give ambiguous results. 

I take your point, that a 20mm slice of a 50mm diameter core may not characterise 

an anode! espec ially if a large butt particle is present, ho wever , I make the 

following comments: 

• These small samples have been shown to correlate with process conditions 

• the principle aim of the project is to be able to diffe rentiate between large 

coke/butt particles and the binder-fines matrix and assess the matrix 

• the sample size we can routinely take out of the plant anodes is restricted 

3 . Assess larger samples with a range of pitch levels. CRC can provide you with 

larger samples, rec tangles 100mm by "'200mm. These samples are 100mm 

diameter cores (sliced in half) from the BSL plant in Queensland formed with a 

variety of pitching levels (measured by slump of the anode) . Please let me know if 

you require them. 

CRC recommend that a lower magnification image analysis technique should not 

be evaluated solely because more of the sample can be assessed by eye and used 

to evaluate the technique. This would not avoid the problem of subjectivity and 

anode structure may be overlooked. Altering the magnification should be based on 

increasing the resolution between samples and test the robustness in steps 1 and 

2 . 

4. Provide Comalco with software which incorporates the more useful techniques 

and allows the user to calibrate them by altering settings (eg gray level, number of 

associated pixels averaged etc). 

Conclusion 

I hope these comments are of assistance. I do not believe that Comalco can provide you 

with samples ranked accurately enough by visual inspection to calibrate your image 

analysis techniques, that is why we are trying to automate macrostructure analysis! 

Macrostructure analysis, like each of our physical tests, can only be evaluated by 

assessing its sensitivity to process changes. 
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APPENDIX F - Sample Descriptions 

SAMPLE ID Descripti on 

12M Slightly overpitched, but gocxi 

compaction. Larger pores are mostly inter-

particle porosity 

4M Overpitched anode. Small to medium pores 

form "rings" around aggregate particles to 

allow excess pitch volatiles to escape 

during baking 

3110 A well pitched and formed anode. 

Consistent structure throughout the 

binder/fines matrix of an evenly distributed 

fine porosity that is typical of an acceptable 

anode structure 

748 Underpitched anode. Medium to large 

pores scauered throughout binder/fines 

matrix. No "rings" around aggregate 

particles also indicate underpitching 
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